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1 Introduction 

The Oasys Ltd LS-DYNA Environment 18.1 suite, dated October 2021, is a full release which 
supersedes all previous releases. It is a bug fix release of the Oasys Ltd LS-DYNA Environment 
18.0 suite. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 17.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 

The 18.1 release has been used and tested with LS-DYNA version R12 and the development 
version of R13. It supports all the keywords in volumes I, II and III of the released R11.0 User’s 
Manual. Most of the new keywords in the released R12 User’s Manual are also supported (only 
some *DUALCESE keywords outstanding). The Oasys 18.1 release also supports the core R13 
*IGA keywords. 

LS-DYNA R9.0 is the default keyword output format from PRIMER. (However, output may be 
generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 

The complete Oasys Ltd LS-DYNA Environment 18.1 is available on the following platforms: 

Windows  Windows 10 

Note that support for Windows 7 has been deprecated as 
Microsoft is no longer supporting Windows 7. As far as we 
are aware, the software runs on Windows 7. 

64 bit 

Linux RedHat Enterprise 7.x, RedHat Enterprise 8.x 64 bit 

For simplicity of support and maintenance only the RedHat Enterprise 7.x build has been 
released on the website for Linux as this has been found to run on all the machines we have 
tested (RHEL 7, RHEL 8, SuSE 12.3). 

If you require a different Linux build, please contact Oasys Ltd. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort.  There are much better ‘thin wire’ graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 
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1.4 Licensing 

This latest version of the software will only use the LM-X licensing platform to provide an 
increased level of license security. FLEXlm is not used for Oasys licensing from version 18.0 
onwards.  

To ensure you’re ready to enjoy all the great features Oasys Suite 18.1 will bring, we recommend 
you update all your Oasys Suite license servers and files as soon as possible.  

Action to take  

If you’re using a floating network license you will need to install the LM-X license server 
software (version 4.9.24). The software and supporting documentation are available to download 
from our website and are also included in our installation packages.  

Backwards compatibility  

The Oasys Suite 18.1 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 18.x, 17.x, 16.x, and 
15.x software will continue to work with new LM-X license files and servers. 
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2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

2.1.1 Bugs Fixed in 18.0 

Adhesive 

• Case 44488 

The From FE (Connection) tool was failing to work for adhesives. This bug appeared when 

connection layers were extended from just shells to solids and thick shells. The solids of the 

selected part (the prospective glue) are now excluded from segment creation. 

Airbag 

• Case 45340 

There are a few data fields in LS-DYNA, for example FRIC on *AIRBAG_PARTICLE, where 

the legal values are something like 

 

Value  ≤ -1 negative label of some item type 

-1.0 < value < +1.0 scalar fractional value, here friction 

Value ≥ 1 +ve label of some item type 

 

In other words depending on its magnitude and sign a value might legitimately be either floating 

point or integer. 

 

PRIMER handles these data fields and performs checks on them during keyed in interactive 

input, typically in an editor. 

 

These checks also apply if the data field is defined by a parameter when typed in, but in this 

instance the check for a floating point parameter did not consider the magnitude of the parameter 

value and rejected it unconditionally (because it was not an integer) even if it lay in the legal 

'scalar float' range in this context. In the example above using a parameter evaluating to 0.3 was 

rejected - wrongly - as not being a valid label in that context. 

 

Fixed by applying the same checks to parameterised floating point input as are applied to plain 

numbers in the same context. 
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Belts 

• Case 44805 

When 2D *ELEMENT_SEATBELT elements are used for a belt the node set EDGSET on the 

relevant *SECTION_SHELL card defines the order of a row of nodes across the belt. This must 

line up correctly with any sliprings and retractors across the belt. 

 

Historically PRIMER has checked this against retractors but not sliprings. It now tracks along 

the belt looking for sliprings and checks these too, ensuring that shell sets SSID1 and SSID2 on 

the retractor are consistent with the element topology implied by EDGSET. 

• Case 44659 

Read CSV for belts: There was error in the generated belt path for certain 'fixity' strings. Fixed 

this. 

Checking 

• Case 45733 

Fixed a crash if a check was run on a model containing *CONSTRAINED_EXTRA_NODES 

which did not contain any IDs. 

• Case 45286 

PRIMER was reporting errors when *CONTACT_FORCE_TRANSDUCER was referring to 

beams. This was not right. This has been fixed now. 

• Case 44846 

If *MAT_ADD_XXX is read but the material referenced was missing, PRIMER set the material 

type code to *MAT_ADD_XXX and model check reported no errors. This type code is now 

reported as out of range for structural material. 

• Case 44791 

Incorrect errors/warnings for *FREQUENCY_DOMAIN_FRF card have been fixed. Zero values 

on <DOF1> and <DOF2> fields are now also permitted. 

• Case 44724 

The check option 'maximum percentage of tria' was causing model check to crash. The error has 

been corrected. 
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• Case 44660 

After element quality check, check categories on the drop-down were un-necessarily greyed out 

and model check was required to restore them. The buttons are no longer greyed. 

• Case 43588 

*DEFINE_CONSTRUCTION_STAGED _PART previously threw an error message when the 

Part’s element type was TSHELL. However, TSHELL part is supposed to be permitted for the 

keyword, so the spurious error message has now been removed. 

• Case 42923  

When reading LS-DYNA output files, the dialogue box displayed an incorrect line count. This 

has been fixed. 

Clipboard 

• Case 43515 

In the clipboard, when moving something to an include file, and choosing 'Master file', instead of 

moving it to the master file, a new include file called “Master file” was being created and it was 

put in there. This has been fixed. 

Connections 

• Case 44918 
 

Connection operations could give rise to unexpected deletion of some or all contacts in the 

model. This was observed to happen on remake of a connection when copy-orient had been 

applied but may occur in other contexts of connection remake. 

• Case 45534 

When an image file (of any type: png, jpg, pdf, etc) was saved with a white background selected, 

and the current screen background colour was not white, some types of sketched graphics 

overlying the plot could be lost. An example would be when modifying a connection the line 

showing the proposed new connection, but a similar problem could occur in other contexts where 

transient sketched graphics have been added to the plot. 

 

This was because redrawing with a different background colour causes some aspects of the plot 

to be recreated, since their colour can be dependent on the background colour. As part of this 

process overlaid sketched graphics were being deleted. 

 

Now fixed: the 'update and redraw' process required to save an image with a different 

background colour will no longer delete overlaid sketched graphics. 
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• Case 44625 

When the option use_parent_layer is switched off for bolts, NRB bolts will be made with 

conventional node set irrespective of the setting 'NRB bolts may use set collect'. The defaults are 

use_parent_layer=true, use_set_collect=true but these can be changed by preference settings. 

• Case 44509 

The NO_ACTION option on the Remove panel will now support deletion of solids from 

adhesive connections. The EMPTY_CONX action is unchanged, i.e. same as NO_ACTION for 

adhesive, for other connections removes all contents. 

• Case 43477 

When the pitch for MIG line weld was set too small, coincident beams appear in the weld run. 

This has been fixed by resetting the pitch to the minimum node-node distance if it is below that. 

• Case 43476 

Weld lines (not MIG) made on panel edges could previously move to the wrong edge on 1st 

remake and then back to correct edge on 2nd remake. This issue did not affect MIG welds which 

are more commonly used on edges. This has been fixed. 

• Case 43056 

When one changes Part ID in the Connection Table and uses 'update connection data', the Part 

ID on the elements was not changing. The missing logic has been added to fix this. 

Constraints 

• Case 43405 

The field STIFF in *CONSTRAINED_INTERPOLATION_SPOTWELD can now take Function 

ID when MODEL field is greater than 10. Also, negative Material ID is not written out in 

versions prior to R12.0 

Contacts 

• Case 44726 

Labels for some fields in *CONTACT_XX_THERMAL_{option} were different to those in the 

R12 LS-DYNA manual. Changed RAD and H to FRAD and H0. 

• Case 44307 

When a PDF image is captured it can sometimes result in the text overlay (that is title, contour 

bar, etc) of the on-screen image going the wrong colour. This problem rights itself as soon as 

mouse movement or any other explicit operation causes a screen refresh. 

 

Caused by an internal problem in the graphics driver and now fixed. 
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• Case 43309 

The ONLY function for contacts was not working when the contact was defined using 

*SET_SEGMENT(_GENERAL). This has been fixed to unblank the elements that lie under the 

segments. 

• Case 43122 

Contact write xls data has been corrected so the reported count of penetrating/tied nodes and the 

min/max penetrations agree with the values given on the part edit panel. 

• Case 38627 

Contact with Soft=2 (segment based) is now analysed using logic which simulates LS-DYNA's 

projection algorithm. This should give much better agreement with results published in the 

mes0000 file. 

 

PRIMER assigns the penetration to the closest node and additionally reports any node to 

segment penetrations as these are valid information and assist the penetration fixer. 

Contour 

• Case 45613 

Contour plotting shell elements with the true thickness option turned on did not draw the shells 

correctly for high-order elements. This has been fixed. 

Curves 

• Case 45304 

Fixed a bug where field values such as SFA in the first line of the load curves would not be 

correctly applied when read in after being exported using the 'Text edit' option. Details below: 

 

When editing a *DEFINE_TABLE definition it is possible to export the table to an external file 

using 'Text edit' for editing in an external editor. 

 

Exceptionally for Text edit, which normally only works on the single entity being edited, this 

exports not only the *DEFINE_TABLE definition but also vestigial *DEFINE_CURVE 

definitions for all the loadcurves that the table references. This is because a table relies on these 

curves following it immediately in the keyword deck. 

 

This gave the impression that it was possible to edit the first lines of these curves, changing 

values like SFA, SFO, OFFA etc. However although these edits would be accepted they would 

not be applied to the underlying loadcurves since the process which re-imported the modified 

table definition after the external edit ignored them. 

 

This has been modified so that changes to these vestigial 'first lines' of loadcurves will now be 
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read and re-imported in this case. This is exceptional treatment which applies only to 'curves 

belonging to a table' in this context. 

• Case 44628 

Scale and offset was being applied unconditionally when clicking Edit curve in PRIMER (from 

T/HIS). This now takes into account whether or not the scale and offsets button is actually on. 

Cut section 

• Case 45583 

Multiple cut planes were not drawn on parts not intersecting the base plane but intersecting 

another offset plane. This is now fixed. 

Database 

• Case 42900 

Field 2 of card 1 (BINARY) in *DATABASE_FSI has been added to the editor. 

Deleting 

• Case 45378 

'Cleanup unused' now works for unused *DEFINE_FRICTION (when no PARTs are 

referenced). 

• Case 43547 

An error check has been added for the case when a load is applied to a massless node. Also 

cleanup unused has been improved to remove such loads. 

Dummies 

• Case 45520 

While updating the Dummy Assemblies, the error/warnings were not getting reported properly. 

This has been fixed. 

• Case 44767 

Problem with obtaining a discrete element ID during simulation based dummy positioning setup 

potentially resolved. Now discrete elements are checked for label clashes during creation of 

spring damper. 
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Edit 

• Case 45279 

'auto-create off/on' button was obscured in *CONSTRAINED_EXTRA_NODES create panel 

which is now fixed. 

• Case 45159 

Fixed bugs which resulted in unintended errors for <MCOUP> and <IBOXID> drop down for 

*CONSTRAINED_LAGRANGE_IN_SOLID create/ modify panel. 

• Case 44770 

The generic editor, used for things like *INITIAL, had a couple of features related to popup 

menus that did not work: 

 

#1 'Compound' fields, meaning those which might be one entity type if +ve, but a different object 

type if negative, appeared to ignore the result of a pick or selection from a popup if the data field 

was currently empty, selection worked OK if the data field already had a value. 

 

#2 Label fields would ignore the result of a right-click popup label selection (1st, 1st in layer, 

etc). 

 

In both cases typing in a value worked fine. 

 

Both were due to internal coding errors and have been fixed. 

• Case 44742 

The third card in *INITIAL_VELOCITY is optional but was set to be processed unconditionally 

in the keyword editor. It has been fixed now. 

• Case 44734 

The fields Q, CQ and SOCINIT on EM_RANDLES_BATMAC, _MESHLESS, _SOLID and 

_TSHELL were incorrectly being rounded to integers when they should be floats. Fixed this. 

• Case 44524 

If *CONTROL_SPOTWELD_BEAM RPBHX applies, the beam part now allows HGID to be 

defined without error messages. 

• Case 44099 

For *DATABASE_PWP_OUTPUT, fields <iaccx/_y/_z> now can have any integer value as 

input which previously had clamping range (0-17). However, warning messages will now be 

displayed if values are not in this range. 
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• Case 44095 

Some 'complex' data fields were not working correctly in all editors: 

 

*DEFINE_BOX_ADAPTIVE field LIDX/NDID (loadcurve if the value was positive, or a node 

if negative) was not being interpreted correctly in the keyword editor. 

 

*AIRBAG_PARTICLE fields FRIC and PFRIC are functions if >1.0, loadcurves if ≤ -1.0, and 

scalar values if in-between. These were defaulting to a loadcurve when positive which was 

wrong. 

 

Both were due to internal errors in the definition and processing of these fields, now fixed. 

• Case 43876 

The fields LCIDD and LCIDT were not being processed correctly on the 

*LOAD_MOVING_PRESSURE create panel. Now fixed. 

• Case 43618 

The error in the generic editor, which caused loadcurves that have negative labels being 

displayed as positive if selected from a popup or created, is fixed. 

Encryption 

• Case 44760 

Blocks of PGP data were getting lost when two models from two different directories were read 

and were output in some new different directory. This is now fixed. 

Errortrapping 

• Case 45140 

Fixed a bug where if the user opens the *ALE_REFERENCE_SYSTEM_GROUP create panel 

in PRIMER and sets PRID to a positive value (while PRTYPE is 0) a warning message about 

PRID being NULL might display in the dialogue box. 

FMH 

• Case 45513 

Column widths in the tree (menu) generated by reading data from a .csv file into the FMH panel 

were set differently for the top (occupied) part and the bottom (empty) portion. This has now 

been fixed. 

• Case 45280 

FMH check panel - made some columns wider so that text (headers & values) fit properly. 
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Formula 

• Case 43147 

Until PRIMER 17.0, input in text boxes, for example edit panels or keyword editors were treated 

as formula when they contain any arithmetic operator +, -, *, / or brackets, even when they had 

not got the = sign as prefix. As this can cause unintended formula evaluation due to typing 

errors, the preference primer*formula_req_equal to require the = sign has now been added. By 

default this is now TRUE, i.e. the = sign is required. 

Geometry 

• Case 44291 

The JT reader library has been updated to the most recent version (10.8). 

Graphics 

• Case 45147 

When using NiceDCV on a remote Linux server with a high-specification Nvidia card the 

graphics window might not be refreshed when a sub-window obscuring it is unmapped or moved 

aside. 

 

This is simply an issue with the NiceDCV setup. To work around this, the user should set the 

GRAPHICS_NO_BACKING_STORE environment variable in the Oasys Ltd. software. 

• Case 44085 

A warning message was displayed unnecessarily in the slider of the 'orient' tool. This has been 

fixed.  

Groups 

• Case 45717 

When decomposing a group containing set parts defined by range (for example, when calculating 

mass properties of group) a crash could occur. Now fixed. 

• Case 44663 

Models read with duplicate groups and the setting to permit duplicates on all keywords could 

hang PRIMER. Now fixed. 
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Include 

• Case 44950 

Fixed issue where *INCLUDE_AUTO_OFFSET and *INCLUDE_UNITCELL were written out 

in LS-DYNA versions incompatible with the keywords. 

• Case 44098 

The include function 'add new child' when used with *INCLUDE_AUTO_OFFSET_USER was 

not applying the label offset correctly. Now fixed. 

Include transform 

• Case 45628 

If a *DEFINE_TRANSFORMATION card contained MIRROR and ROTATE transforms 

PRIMER could get the combined transformation wrong. Now fixed. 

• Case 44482 

Fixed a bug involving lost *PARAMETER_DUPLICATION cards when defined in an 

*INCLUDE_TRANSFORM file, and increased the speed of processing parameters. Explanation 

below: 

A model which contains self-referential *INCLUDE_TRANSFORMs, (generically include file 

A includes file B, which includes A using some different transform) caused PRIMER some real 

problems when some of those transforms were defined by *PARAMETERs which were 

themselves defined in an include file that underwent transformation. 

 

This led to parameters being duplicated, requiring a *PARAMETER_DUPLICATION card to 

placate LS-DYNA, and while PRIMER read this it card it got lost during the processing of 

include transforms. In addition the 'sorting out' phase of parameter processing took an impossibly 

long time. 

 

In PRIMER 17.1 the only fix that has been made is to correct the problem that 

*PARAMETER_DUPLICATION cards go missing if they are defined in an 

*INCLUDE_TRANSFORM file. The speed problem can be solved by using the option to pre-

read parameters. 

 

In PRIMER 18.0 the above fix carries over, but in addition the speed problem of sorting out 

parameters has been tackled so that their usage inside *INCLUDE_TRANSFORM is now 

resolved at least 20x faster than before. 

 

However putting parameters that will be used to define transformations inside a file that will 

itself be transformed and duplicated is not recommended. Unlike LS-DYNA, PRIMER has to 

'remember' all these duplicate definitions, and sorting them all out requires a lot of processing. It 

is strongly recommended that users put their parameters either in the master file or in a single 

include file that is read before anything else. 
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Integration 

• Case 45500 

In the LS-DYNA output tree D3PLOT can be opened at a given time state by right-clicking on 

entities. When no result files were available, D3PLOT crashed. Now PRIMER no longer opens 

D3PLOT in those cases. 

• Case 43198 

Message about results found when clicking the button 'Post' in PRIMER. Now we distinguish 

between D3PLOT and T/HIS results. 

JavaScript API 

• Case 45783 

The SetMesh() method for the Belt class includes a segment index (number) and a 'data' object. 
The data object includes a property called 'mode' which allows users to change the mesh mode 
used for a particular segment. This can, for example, be used to convert a full 1D mesh segment 
to a mixed 1D/shell segment. Changes to 'mode' would not have worked correctly in previous 
versions. This has now been fixed. 

• Case 45606 

If a script restricted access in a window by using the Window active property and played a macro 

that opened the 'pre output check' window, set some options, and closed it, the restriction would 

be lost. Now fixed. 

• Case 45469 

It was not possible to set a beta angle of 0 for a shell from JavaScript as setting beta to 0 unset 

the _BETA option. The logic has now been changed so that beta can be set to 0. Setting beta to 

null unsets the _BETA option. 

• Case 45263 

If a property on a control card was edited the control card could move to the current include file. 

Now fixed. 

• Case 45258 

Previously, the PRIMER JavaScript API would return the wrong value for 

model.control.contact.isym. Now fixed. 

• Case 45252 

Previously, setting the MID property on a new layer on *PART_COMPOSITE via the JavaScript 

API function Part.SetCompositeData() would not create cross-references between the material 

and part composite. This has now been fixed. 
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A similar issue could also affect the entities in the following properties: 

 

- *BOUNDARY_PRESCRIBED_FINAL_GEOMETRY: NID 

- *INITIAL_VELOCITY: IRIGID 

- *LOAD_NODE: M3 

- *CONSTRAINED_NODAL_RIGID_BODY: PNODE 

- *SECTION_SHELL: ELFORM, EDGSET 

- *SECTION_SOLID: ELFORM 

- *SENSOR_SWITCH: SWIT 

- *ELEMENT_(T)SHELL_COMPOSITE: MID 

 

These have also been fixed. 

• Case 45239 

In PRIMER, when using JavaScript to delete a model, input was restricted after the deletion 

which prevented the window from being used. Now fixed. 

• Case 45229 

Fixed *CONTROL_IMPLICIT_EIGENVALUE JavaScript API support for EVDUMP. 

• Case 44965 

Previously, PRIMER would crash when providing the Curve class constructor with an invalid 

Load Curve type. This has now been fixed - the JavaScript API will now report an exception 

instead. 

• Case 44701 

Previously, trying to set the M3 property for LoadNode, in the PRIMER JavaScript API, to a 

negative value via the property setter or constructor would not work. This has now been fixed. 

• Case 44685 

Previously, accessing the icid property of the VelocityGeneration class, in the PRIMER 

JavaScript API, would return the wrong value. This has now been fixed. 

• Case 44683 

*CONTROL_MPP_DECOMPOSITION_FLAG_STRESS_STRAIN_CURVE was previously 

not accessible via JavaScript. This has now been fixed. 

• Case 43829 

Previously, when calling File.Delete(pathname) through the PRIMER JavaScript API, on a 

Windows machine, the pathname would not be deleted if it were a directory. This has now been 

fixed. 
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• Case 43347 

JavaScript category is now respected even after foreground and background colour may have 

been previously changed. 

• Case 42405 

The Section JavaScript class was not processing character labels correctly in its constructor. This 

has now been fixed. 

Keyword 

• Case 45215 

For *SECTION_BEAM_AISC: 

- Corrected value K from float to integer 

- Corrected keyword editor for ELFORM 12 

• Case 45078 

Units for *ICFD_BOUNDARY_PERIODIC fixed. 

• Case 44993 

In *ALE_STRUCTURED_MESH_MOTION, <EXPLIM> was treated as an integer rather than 

floating point, which now has been fixed. 

• Case 44956 

For *MAT_SEISMIC_ISOLATOR, if ITYPE is greater than 2 then, it used to convert it to 0 but 

dependent cards were still written out. This is now fixed. 

• Case 44856 

All the *DUALCESE keywords now appear in the quickfind search list. 

• Case 44467 

Fixed incorrect conversion of units in some *EM keywords. 

• Case 44438 

*LOAD_ALE_CONVECTION_ID did not have a title in the additional card for the ID option. 

This is now fixed. 

• Case 43986 

MAT_119 and MAT_121 headers UNLDOPT have been corrected to IUNLD. 
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• Case 43765 

*PERTURBATION_MAT was unable to be read in previously. It is now fixed. 

• Case 43472 

PRIMER showed incorrect number of cards present, in *EM_CONTACT keyword-popup, 

which now has been fixed. 

• Case 43333 

Added support for Function and Table creating options for the following fields: 

<R0CHA> <R0DIS> <R10CHA> <R10DIS> <C10CHA> <C10DIS> in 

*EM_RANDLES_MESHLESS, *EM_RANDLES_BATMAC, *EM_RANDLES_SOLID and 

*EM_RANDLES_TSHELL. 

• Case 43311 

PRIMER showed incorrect number of cards present, in *EM_CIRCUIT keyword-popup, which 

now has been fixed. 

• Case 43275 

Field activation issue resolved for TMOD > 5 on *ICFD_CONTROL_TURBULENCE. 

Kwd editor 

• Case 44601 

The generic editor could produce additional garbage if a model contained PRIMER-specific 'user 

data' after *END. This is a very rare occurrence, so unlikely to happen in practice, and now 

fixed. 

Labels 

• Case 44516 

When reading a model with duplicate contact labels, PRIMER can change the labels to declash 

them. Sometimes this declashing used the same new label for more than one contact at a time, so 

that the labels were actually still clashing. This has now been fixed such that the labels become 

unique after declashing. This also avoids other errors and crashes later on in a PRIMER session 

where such a model has been read. 

• Case 43924 

PRIMER has always checked to see if a model can be written out in the selected small / i10 / 

large format, offering to renumber the model if required. This check had an error in that while it 

checked the contents of each include file it did not check what items in that include file referred 

to. For example *ELEMENT_SHELL in include file A might refer to *NODE definitions in 

include file B, and if the contents of file A were 'small' but those in file B were 'large' the 
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potential for overflow would not be detected. 

 

The following fixes and changes have been made to correct this: 

 

+ In 'Automatic' and 'Keep existing' keyout modes PRIMER now does an internal 'test write' of 

the model which will detect any overflowing fields reliably. 

 

+ This information is stored at a resolution of 'item type in include file', that is PRIMER records 

that - say - *ELEMENT_BEAM in include file C overflows its data field. 

 

Three sizes of output are available: 'small', 'i10' and 'large' and we refer to increasing the format 

from a smaller size to a larger one as 'promotion'.  Given the level of detail at which overflowing 

data is recorded this makes it possible to promote the format of output from at three levels of 

detail: 

 

  (1) The whole model.     } Set on the *KEYWORD 

  (2) A whole include file } header card 

  (3) Individual keywords in an include file using % or + suffices 

In 'Automatic' mode the chosen level of promotion (default = whole include file) is applied 

automatically; in 'Keep existing' mode you are informed and must choose which to apply. 

 

The existing check for the largest label in the model is retained for the explicit small, i10 and 

large output options; likewise the existing 'renumber model to fit format' option is also retained. 

Macro 

• Case 44518 

Macros to expand tools and keyword menus now work after changing and applying defaults in 

Window size and layout. 

Manual 

• Case 45710 

In some cases on Linux, PRIMER could fail to open the HTML manual if the machine was used 

by multiple users. Now fixed. 

• Case 44741 

Users can now use the preferences 'All programs*pdf_application' and 

'primer*pdf_keywords_arg' to open the keyword manual at the correct page using their preferred 

pdf reader. 
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Materials 

• Case 45344 

In *MAT_SPOTWELD_DAMAGE-FAILURE, USERV10 - USERV14 fields were incorrectly 

omitted while writing out in LS-DYNA versions <R12, which is now fixed. 

• Case 45142 

In *MAT_SEISMIC_ISOLATOR when ITYPE is set to 0 and IEXTRA is set to 1, values 

entered in KTHX, KTHY, KTHZ were lost. This issue has been fixed. 

• Case 44251 

Load curves now start from TSRFAC=2 for the keyword *MAT_FABRIC 

• Case 44025 

Material definition written within *ENCRYPTED_START and *ENCRYPTED_END was not 

full. Now it will write full material definition with zeros for fields that were not defined when 

read. 

• Case 43617 

*MAT_SEATBELT_2D can now be used in the JavaScript material constructor. 

Mechanism 

• Case 44853 

Repeated clicking on Global Accuracy button under Mechanism panel no longer compounds 

calculations on convergence factors. 

• Case 44260 

Radio button default in Mechanism → Position → Options is now set to 'Draw normal' instead of 

'Draw wireframe' when 'Reset defaults' is pressed. 

Menus 

• Case 44861 

Colour palette wheel no longer disappears if the colour chosen is black. 
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Merge 

• Case 42587 

When merging two models and setting destination include in Model → Merge panel, it was not 

moving blocks of PGP to target include and instead ending up in master file. This issue has been 

fixed. 

Mesh 

• Case 45225 

In a model with connections, the creation of swages would sometimes delete the solids and 

connections in the model. Fixed this. 

• Case 43894 

When there are say three cylinders and third cylinder's radius is less than or equal to second 

cylinder's radius, PRIMER was crashing. The 'Apply' button has now been greyed out for such 

situations to prevent this from happening. 

 

Also when the difference in the radii between two adjacent cylinders was less than the element 

size chosen, PRIMER used to crash. This also has been fixed by checking for this condition, 

showing a message in the dialog box and breaking from the function. 

• Case 43318 

Selecting nodes using 'screen area' and 'screen polygon' did not necessarily return the nodes in 

order. Now if the selected nodes are on the free edge, the node order is rearranged before 

extrusion. 

Model modified 

• Case 42860 

Reporting change of include file in model modified is now OFF by default. The function did not 

always work correctly on connections. This has been fixed. 

Morphing 

• Case 44426 

When picking morphing drag handles in Selection mode and then changing visibility of corner, 

edge, face and/or internal points, sometimes different handles or points appeared as selected. 

This only affected the sketching, not the actual morphing. This has now been fixed. 
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• Case 43068 

Previously, when merging nodes owned by morph boxes the parametric coordinates for the 

resultant node and its morph box were not updated. Furthermore, the merging of nodes owned by 

the same morph box was not allowed. This has been fixed such that nodes owned by the same or 

different morph boxes are allowed to merge together. The morph box that will own the resultant 

node can either be the box that has the highest or lowest label, out of the group of boxes that own 

the selected nodes. This option can be specified by the preference 'replace_morb_entry', set to 

'HIGHEST' or 'LOWEST', or set in the program options panel. 

 

The same issues also occurred when using Node replace, which have also been fixed as outlined 

above. 

• Case 43052 

Previously, when trying to create a morph box with pre-existing morph points, via the PRIMER 

JavaScript API, if an error was thrown because some of the flagged nodes were already owned 

by another morph box PRIMER would still create a new morph box, albeit empty. This has now 

been fixed such that a new morph box is not created when this error is thrown. 

Nastran 

• Case 44233 

The character limit for NASTRAN include filenames has been increased to 600 characters. 

Nodal RB 

• Case 44772 

Repeated creation (autocreate off) of *CONSTRAINED_NODAL_RIGID_BODY with _SPC 

option lost the option and the values set for CMO, etc. These settings are now preserved whilst 

the edit panel is active. 

Orient 

• Case 44487 

Orient → Reflect previously changed the order of nodes on shells, but this did not reorder the 

thicknesses for *ELEMENT_SHELL_THICKNESS. Now the thickness values are reordered in 

the same way. 

• Case 44143 

When orients are encoded by *INCLUDE_TRANSFORM in the orient tool, the process checks 

that no explicit orient has been previously applied to the include by reading in the original to 

model zero and remaking the transforms. The process can give numerical discrepancies 

particularly with rotations. The logic for comparing coordinates has been made more robust to 

avoid spurious warning message which blocks progress. 
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Output 

• Case 45376 

Fixed several keyin and keyout bugs involving the i10 format for keyword cards. Details below: 

 

PRIMER supports small, i10 and large formats by reading and writing the relevant suffix on the 

*KEYWORD card at the top of a file, for example '*KEYWORD i10=y'. 

 

However LS-DYNA only considers that suffix when reading the master file of a deck, ignoring it 

on any child include files, since child includes are presumed to have the same format as their 

parent. If a child include file is to have a format that is different to that of its parent then the 

*INCLUDE statement must have a %, + or - suffix (for i10, long or short format respectively). 

 

PRIMER - wrongly as it turned out - presumed that putting the suffix on the *KEYWORD 

header would suffice, and did not add any suffices to the *INCLUDE keyword. So if it wrote 

mixed format decks these would not read into LS-DYNA. Therefore the following fixes and 

changes have been made: 

 

On keyin: 

 

+ PRIMER now defaults to 'child include inherits format of parent' if no suffix are present on the 

parent *INCLUDE statement. (This behaviour was always available as an alternative, but it was 

not the default.) 

 

+ PRIMER (unlike LS-DYNA) still inspects and considers any suffix on the *KEYWORD line 

of a child include file. If a suffix is found this is presumed to be the 'true' format of the file, 

superseding any inherited or implied format in the parent file. 

 

On keyout: 

 

+ When the format of an include file is different to that of the master file of the deck then 

PRIMER now always adds the relevant %, + or - suffix to the relevant *INCLUDE statement. 

 

+ Any include file that is in i10 or long will have 'i10=y' or 'long=y' respectively added 

unconditionally to the *KEYWORD line at its top. 

 

+ An include file in 'small' format written in a deck where the master file is not 'small' will have 

the suffix 'long=s' added to its *KEYWORD card. 

 

The addition of suffices to *INCLUDE in the parent file and to *KEYWORD in the child file 

introduces a degree of redundancy into this process, hopefully future-proofing it. It also means 

that if a child include file in i10 or long format is read in isolation it should still be processed 

correctly. 

• Case 44860 

Added field headers to card *MAT_ADD_COHESIVE. 
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• Case 44825 

*DEFINE_PRESSURE_TUBE was misread by PRIMER when the optional card 2 was omitted 

and card 3 was present for TYPE = 1 or 2. 

• Case 44483 

When a model with includes was written in 'merge to master' mode the *TITLE was written 

above *END (as when the model is written with includes). This has been corrected so *TITLE is 

written at the top of such a deck. Previously, the default position is top for model with no 

includes or written in 'merge to master' and bottom for model written with includes. In PRIMER 

18.0 this behaviour is configurable by the preference 'dyna_placement_title' which the user can 

set to DEFAULT, TOP, BOTTOM or BOTH. 

• Case 43053 

When include files are compressed and/or binary, now a compressed and/or binary icon is shown 

at the end of the string file name in the include tree view. When hovering over the file name an 

explanation of what it means pops up. 

Parameter 

• Case 45277 

*LOAD_BODY parameter names now display in the Vector option fields, where they previously 

only showed the numerical values. 

• Case 44834 

Fixed a bug where a false comparison error is displayed when running a Model Modified check 

between a model and the same model whose parameterised data field had been modified, the 

model then written out, and read back in. 

 

It is possible to get a spurious Model Modified comparison error by the following method: 

 

+ Have a model with a parameter in some data field. 

 

+ Orient, or otherwise change, the model such that the value of that data field changes. This 

means that the parameter is no longer valid in that field because parameter value and underlying 

data field value no longer match. 

 

+ Write the modified model out, then read it back in to a new model. 

 

+ Run a Model Modified check on original vs new model. This can show a difference, claiming 

that the parameter is still used in that data field in the original model but not in the new one, 

which is not correct. 

 

The reason for this is that it would be prohibitively expensive to check whether every 
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parameterised data field is still valid each time the model changes in any way, so PRIMER does 

not do this. Instead it leaves the association between parameter and data field until such time as 

this is exposed to the user, for example when editing the entity, copying it or performing a 

keyout operation. It is passage through these operations which expose the difference which 

triggers the removal of the association. 

 

For speed only the edit/copy cases actually remove the internal parameter association, keyout 

does not, so in the sequence above it can be seen how the error arises. It can also be seen why 

this is quite a rare occurrence. 

 

This has been fixed by adding 'Model modified comparison' to the list of operations which check 

and remove the association between a parameter and a data field in which it is used, removing 

the association if necessary before performing the comparison. 

• Case 44763 

A model which used a parameter for the IRIGID field on *INITIAL_VELOCITY generated 

internal errors during 'orient' if the parameter was not defined, or used before it was defined. 

 

Nothing to do with parameters: the IRIGID field was incorrectly programmed such that certain 

internal operations, which happened to include resolving unknown parameters, would cause 

internal errors. 

 

Now fixed. 

• Case 44500 

Fixed a few bugs related to *PARAMETER_DUPLICATION behaviour:  

 

The way that *PARAMETER_DUPLICATION had been added to PRIMER was wrong in 

PRIMER 16.0 and 17.0 because when it first appeared some incorrect assumptions were made. 

 

Since then the LS-DYNA user manual has been clarified and PRIMER has been revised to make 

this card work correctly. 

 

Symptoms of previous wrong behaviour were: 

 

- Treating a multiply-defined parameter that should be ignored as implicitly _MUTABLE in 

some circumstances. 

 

- Sometimes not ignoring / accepting the correct instance of a multiply-defined parameter. 

 

These errors have been fixed, and *PARAMETER_DUPLICATION in PRIMER is now handled 

rigorously according to the rules spelled out in the LS-DYNA manual. In particular, input decks 

with wrongly ordered cards are detected during keyword input and the model is corrected to 

remove ambiguities arising from this. 
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• Case 36596 

*PARAMETERS can now be used on *MECHANISM definitions on assemblies, connections, 

points, children and stretches. Previously PRIMER would have read models with parameters 

there, but replaced parameters with their values. 

 

Now PRIMER keeps the parameter references when reading, copying or writing models and 

allows to update parameter values as on ordinary LS-DYNA keywords, but parameters are still 

not fully displayed on the mechanism edit panels. 

Part table 

• Case 43348 

The part table only showed CON1, CON2 for rigid parts if CMO = 1. This has been modified so 

values are shown for CMO = 0 or -1 as well. CMO has been added as a new column on the table. 

Also, a new warning check is given if CMO = 0 and CON1 or CON2 is set. 

Part tree 

• Case 43693 

In previous versions, include files could not be deleted in the 'Contents' mode in the Part tree. It 

worked fine in the 'Include' mode. 

 

This has been fixed now. 

Pedestrian 

• Case 45406 

Lower leg and upper leg bumper GTR impact tests now have impact points lying within the 

bumper test area specified by paragraph 3.10 in the GTR regulation document. 

Preferences 

• Case 45505 

PRIMER now gives out confirmatory window message while saving preferences in SQUASH 

SUB-PANEL 

• Case 43805 

The command line option -pref=/xxx/yyy/custom_pref had 2 bugs. 

- it was only reading runtime prefs and ignoring startup prefs 

- if the preference primer*script_dir was used in custom_pref it got ignored 

Both these have been fixed. 
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Program crash 

• Case 45245 

In certain cases the following sequence of JavaScript commands: 

 

+ Open an object menu, for example Part.Select(...) 

+ Move the mouse into that menu and use a keyboard short-cut key 

 

could cause a crash. 

 

This was because keyboard user events passed from JavaScript were being misinterpreted in this 

context due to an internal error. Now fixed. 

• Case 43962 

Fixed a bug where PRIMER crashed upon opening Discrete under the Element Keyword 

dropdown, after creating SENSOR_DEFINE_ELEMENT with ETYPE as DISC-ELEM and 

some latent entry in ELEMID. 

Read 

• Case 45019 

PRIMER now reads *BOUNDARY_PRESCRIBED_MOTION_SET_SEGMENT without 

having to add an empty card 2. Additional card 2 is expected if DOF = 9, 10, or 11 or VAD = 4 

on Card 1, otherwise it is skipped. 

• Case 43121 

PRIMER will not crash now when file reading is interrupted by dragging and dropping a new 

file before the previous file has finished reading. 

Renumber 

• Case 45622 

1. Include file with unlabelled content will be shown last for Include entity labels sort option. 

2. If general checkbox is turned off, it should now show include files in the correct order. 

• Case 45016 

Fixed some label clash bugs related to BEAM field by changing the relabelling logic. Details 

below: 

If the BEAM field on *DATABASE_BINARY_D3PLOT is set to tell LS-DYNA to generate 

extra beam elements to duplicate DISCRETE and 1D SEATBELT elements this can cause label 

clashes if existing beams of the same labels exist. 
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PRIMER checks for this before keyword output and offers to relabel discrete and seatbelt 

elements if required, but the relabelling logic was very conservative and tended to result in larger 

than strictly necessary label increments. Normally this would not matter, but if the result was to 

increase the labels so that they exceeded the field width in the current output format this would 

require a larger output format to be used, and a second relabelling process to be gone through. 

 

To try to avoid this the following changes have been made to this logic when a clash is detected: 

 

+ Relabelling will now use the minimum shift of discrete and seatbelt element labels to move 

them out of the way of existing beam labels, while keeping the existing spacing between labels. 

 

+ A further check is made to ensure that this minimum shift will not push their label range 

beyond what can be represented in the model's current 'soft' label limit. (99,999,999 for small 

format; 2,147,483,647 for i10/32 bit format; and so on) If this limit will be breached then the 

labels are made sequential with no gaps. 

Scripting 

• Case 43431 

Sled_test, sba, and luggage_retention JavaScripts were showing a small empty label box above 

the '<<< Go back to panel' button. It has been deleted. 

Selection 

• Case 45612  

Feature line screen-picking of parabolic shell elements could cause a crash.  This was due to an 

internal error resolving the extra mid-side nodes on these elements. 

Now fixed for these elements, and also for 8 noded segments on parabolic element faces which 

would have suffered from the same problem. 

• Case 41168 

Screen area picking of types for which the entity switch is OFF were using simple area pick. For 

items which use the visibility of the underlying element (e.g.contact, element_mass_part, 

database_history, set) the pick should only apply if an underlying element is visible. e.g. if all 

parts of a contact are blanked, then the contact should not select. Also a new preference has been 

added primer*visible_entities_only_on_object_menu:ON so that strict visibility can be enforced. 

Sets 

• Case 44603 

Propagation of selected items in ALE models could select too many parts. This has been fixed. 
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Timestep 

• Case 43545 

Use of DT on MAT100 for mass scaling is non-preferred as it is rather unclear what the added 

mass actually is. A new warning check will warn if DT is set and offer autofix to zero DT(s) and 

set the model timestep from the smallest non-weld element 

Units 

• Case 44708 

For VFLAG=1, units of G[i] previously changed the value of the field, which was incorrect. 

Now, no change to the value occurs upon changing the units. 

• Case 44676 

Corrected the units of BSTART, BSTARK and beta[i] to U_REC_TIME (wherever applicable) 

in materials 73, 76, 134, 276. 

• Case 44546 

Unit conversion on MAT_138 fields GIC and GIIC has been corrected. 

User interface 

• Case 45597 

Fixed an issue with Dynamic viewing where certain button combinations would result in 

inconsistent item selection in the graphics window.  

Dynamic viewing in both PRIMER and D3PLOT suffered from an annoying problem in the 

following situation: 

 

+ Click a mouse button and start moving the mouse, far enough to initiate a screen area 'drag out 

area' selection operation. 

 

+ Click shift or ctrl keys to initiate dynamic viewing. Mouse motion now influences the current 

view and the cursor changes to show this is the current operation. 

 

+ Release mouse button or shift/ctrl key. 

 

This would revert to the original 'area selection' operation, but this might now be invalid as the 

model has moved. Typically the screen rectangle will no longer be rectangular, and what is 

within it will have changed. 

 

A variation on the above is when area selection is not wanted, but a dynamic viewing is started 

too hastily with the mouse (click and drag before shift/ctrl is pressed) with the result that what 

the user thought was a simple view change operation becomes some sort of selection one - 
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typically unwanted blanking if the default quick pick mode is current. 

 

These problems have now been fixed in both codes. The fact that what was an area drag has 

mutated to become a dynamic viewing operation is now detected, and when dynamic viewing 

finishes the code now 'knows' that area selection is no longer valid and does not try to resume it. 

• Case 45558 

- Corrected a typo in an error message for not selecting a model when running 

Dummy_Finger_Assembly_Creation_Script.js. 

 

- Corrected a typo in an information window when reloading a property file (.prp). 

 

• Case 44346 

In the Renumber Includes panel, the text boxes under 'Range unique?' and 'In range?' for main 

model were not turning green when the fields had correct values. This has been corrected now. 

• Case 44330 

Switching between the Light theme and any other theme, or vice-versa, causes the background 

colour of the plot to swap between black and white so the plot is redrawn with the new colour in 

SH shaded mode. 

 

However if the current plot contained 'mixed mode' plotted elements that use HI hidden line 

mode their background colour failed to be updated to the new background colour until a new 

explicit plotting command was given. 

 

Now fixed: if changing theme also changes the plot, background colour mixed mode HI plotted 

elements will update correctly. 

• Case 44299 

The 'Preview Mesh' button in Mesh → Ruled remained grey throughout in the new UI. Now it 

has been modified to change colour when it is supposed to. 

• Case 44106 

The red warning button on dialogue box previously did not function correctly when clicked 

while writing out .ztf files. This is now fixed. 

• Case 43698 

Text now fits on the following buttons in the new UI: 

'→pencheck.csv', 'Incl scale and offsets' 
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• Case 43600 

In the Connection → Contact panel, the following 3 buttons were grey. They are now green (as 

they used to be in the old interface): 

- DELETE & REMAKE CONNECTION CONTACT 

- Repair NOT-CONNECTED 

- Repair NOT-STICKING 

• Case 43582 

The BPRM animation has a pair of + / - buttons for framerate control. They had different 

colours. They are now consistent with each other. 

• Case 43440 

The SFA, SFO, OFFA and OFFO textboxes in the DEFINE_CURVE editor no longer change 

colour to green when the 'Incl scales & offs' option is toggled on. Instead the labels above them 

change to the corresponding toggle button colour of every theme. 

• Case 43432 

Listing and settings panels of contour and vector plots had a blank area on the RHS. These 

panels have now been made narrower. 

• Case 43430 

Colour of parameter button (in top-right corner of panels) not appropriate in the dark or light 

themes. Changed from dark blue to light blue. 

Views 

• Case 41566 

Fixed PRIMER crashing when screen picking nodes while using Match Image under the 

Viewing toolbar dropdown. 

Volume 3 

• Case 43826 

Filter functions for ICFD keywords now work correctly. 

Write 

• Case 45516 

When a model contains one or more compressed include files these will have extensions .gz or 

.zip. In the normal case of writing them out in the format in which they were read these 

extensions will be preserved, however if the model is subsequently written out in uncompressed 
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form it could end up writing child.key.zip when the file was in fact not a .zip file. Likewise .gz. 

 

This was a simple omission: the case of 'child file was compressed but is no longer' had not been 

considered in the filename revision logic. Now corrected. 

• Case 45248 

When packaged .zip file output was chosen and the destination for include files was 'same as 

master' PRIMER wrongly put include files in a sub-directory in the .zip file. 

 

This made the resulting file package unreadable since the master file did not have any pathname 

for that sub-directory in *INCLUDE filenames (correctly, because they were meant to be in the 

same directory) yet the files themselves were in a sub-directory within the .zip package. 

 

This was an internal error: the 'same as master file' include file destination was not considered in 

the special logic used to write .zip file packages. Now fixed. 

• Case 44745 

*EM_MAT keywords have now headers for every instance. 

• Case 44743 

*EM_ISOPOTENTIAL_CONNECT now writes keyword headers for each instance of the card. 

• Case 44517 

When reading a model that contains skipped data and then writing it out in merge in master 

mode, skipped data was not getting inserted back. This has been fixed now. 

• Case 44484 

From R9.0 onwards LS-DYNA permits individual keywords to be promoted to I10 input format. 

PRIMER now takes advantage of this as follows: 

 

V17.1: A simple 'promote small format keywords that contain 8 wide fields to I10 format' switch 

is added. 

 

V18: The same switch is added but it has the options 'Promote if needed', 'Promote always' and 

'Promote to I10 / large if needed'. 

 

In V18 the 'automatic' and 'keep original' format keyout options also have options to promote 

individual keywords. 

• Case 44071 

Writing a .ztf file for a model with thick shells which had erroneously been assigned 

*SECTION_SHELL was found to crash as the extraction of integration points (nip) failed. 

Though this is a user error, some traps have been added to PRIMER to prevent the crash. 
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Xref 

• Case 43337 

The cross-reference tree when invoked on a dummy or mechanism was not showing the items 

that it refers to such as 'dummy mech assembly', 'mech connection', etc. This has now been 

corrected. 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 18.1 
 

Ove Arup and Partners Limited | Final | October 2021  

 

Page 32 
 

2.1.2 Bugs fixed in 18.1 

Belts 

• Case 46825 

In the seatbelt path editor it is possible to adjust the 'twist' of the path at points. In the particular 

case of a B-Post slipring this was not working correctly if the user attempted to adjust the twist at 

the end of the belt from dummy to slipring, causing the path to be distorted. This was because 

the special logic which restricts rotation of a B-Post slipring to rotation about the axis of the 

notional bolt by which it is attached to the B-Post was not working correctly. 

 

This has now been corrected: it now doesn't matter which side's twist handle you use at a B-Post 

slipring as both will only affect the 'correct' axes of twist. 

• Case 46358 

There was an error in the additional checks added in PRIMER 18.0 for 2d seatbelts. If a belt 

containing 2d sliprings contains 2d belt elements or shells that are in more than one 

*SET_SHELL then a crash may occur while checking *SECTION_SHELL cards if the first shell 

set on an element is not the one used on the *ELEMENT_SEATBELT_SLIPRING card that 

refers to this element. 

 

This was due to an internal error that is fixed in PRIMER 18.1 

• Case 46146 

The seatbelt fitter has an optional 'initial depenetration' phase which attempts to sort out any 

small penetration errors in the belt path before the form-finding (fitting) process commences. 

This also tries to depenetrate any sections where belt paths inter-penetrate, typically at the entry 

and exit points of sliprings, which requires it to choose which path segment should be 'in front' 

and which 'behind'. 

 

By default this in front / behind determination of overlapping belt segments is calculated 

automatically, using a majority voting algorithm. Occasionally it comes up with the wrong 

answer with the result that a belt path which is correct, even though it has no inter-penetrations, 

can end up being messed up by a spurious attempt at initial depenetration which tries to move the 

wrong belt path segment to the front. 

 

This has been fixed as follows: 

 

In PRIMER 18.1 a 'behind' segment is only moved if it actually inter-penetrates, or is very close 

to doing so. Previously it would be moved even if it was quite a long way from inter-penetration. 
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Blanking 

• Case 46243 

Previously, PRIMER would crash when applying the 'Only' function for a *SET_XXXX from 

the docked *SET panel if some intermediate model numbers had been deleted e.g. models 1, 2, 5 

existed in the model where models 3 and 4 had been deleted (while model 5 was in existence). 

 

This has now been fixed. 

Checking 

• Case 46877 

LS-DYNA submission in PRIMER: the panel input restrictions were getting messed up while 

updating the LS-DYNA keyword output options during 'Initialise in LS-DYNA check'. Fixed 

this. 

• Case 46747 

PRIMER could crash if the keyword option for an item in the check tree was selected during a 

model check if there were custom JavaScript checks for the item type. Now fixed. 

• Case 46306 

JavaScript check strings could be lost or corrupted due to some incorrect memory management. 

Now fixed. 

• Case 46218 

Incorrect error check for NEIPB field on DATABASE_EXTENT_BINARY removed. 

• Case 46053 

If *AIRBAG_REFERENCE_GEOMETRY for a node is defined but that node label has no 

actual *NODE card PRIMER correctly detects that the node is effectively 'referenced but not 

defined'. 

 

Many versions ago this error detection used to have an auto-fix which would create the node 

using the reference geometry coordinates, but this auto-fix has ceased to work since (at least) 

PRIMER 13.0. 

 

The fix for this is version-specific: 

 

In V18.1 an autofix has been added to this error when detected as part of the checking of 

*AIRBAG_REFERENCE_GEOMETRY, allowing all such nodes to be created automatically. 
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• Case 46001 

Previously, when checking *CONSTRAINED_JOINT_STIFFNESS_TRANSLATIONAL, 

PRIMER would log the following as errors: 

 

- NSDX is not negative (and similarly for NSDY, NSDZ) 

- PSDX is not positive (and similarly for PSDY, PSDZ) 

 

This has been fixed such that: 

 

- NSDX is greater than PSDX is logged as an error (similarly for NSDY/PSDY, NSDZ/PSDZ) 

- NSDX is equal to PSDX is logged as a warning (similarly for NSDY/PSDY, NSDZ/PSDZ) 

• Case 45959 

Previously, PRIMER would issue error S_AB_004 ‘Birth time exceeds death time’ for SENSOR 

CPM AIRBAG when TDEATH was set to 0.0. This was not needed, as default TDEATH 

appears to be 0.1E21 in the otf. 

PRIMER now will not give the error message when TDEATH is not set. 

• Case 45560 

Using the _THICKNESS option for 2nd order shell elements was being raised as an error by 

PRIMER's checking tool, whereas LS-DYNA will run to a normal termination when this option 

is set. PRIMER no longer raises this as an error. 

• Case 44840 

Custom JavaScript checks did not work for parameters. Now fixed. 

Composites 

• Case 46050 

When switching a TSHELL part to composite, the _TSHELL option is now automatically 

activated. 

Connections 

• Case 46340 

Previously in PRIMER, a bolt module that contains SET_COLLECT did not read correctly. This 

has now been fixed. 
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Contacts 

• Case 45991 

If the '%' suffix is used after the *CONTACT keyword, for example 

'*CONTACT_SURFACE_TO_SURFACE %' then PRIMER will fail to read this keyword, 

treating it as having invalid data after a valid header and putting it into a skip file. 

 

The reason is because the '%' is detected and removed, leaving trailing white space, and this is 

misinterpreted as a bad suffix. In fact a *CONTACT keyword with trailing white space would 

show the same error. 

 

Now fixed. 

• Case 45963 

Use of SNRDE > 0 was incorrectly reported as error when SOFT=2. The check has been 

removed from PRIMER 18.1. 

Crash test setup 

• Case 46478 

Fixed the bug not highlighting selected and active buttons. Updated UI to make the appearance 

better throughout all GUI themes. 

Dummies 

• Case 46293 

When the user modifies the label value for a DUMMY (or a MECHANISM) assembly, PRIMER 

would throw an error about duplicate assemblies being referred by the children of those modified 

assemblies. This was a false error and is now fixed. 

Edit 

• Case 45160 

In the create panel of *BOUNDARY_THERMAL_BULKFLOW, changing option to SET did 

not change ID to SET_BEAM. This has now been fixed. 

Encryption 

• Case 46818 

When an input file contained free-standing PGP encrypted data and this occurred before cards 

which will handle partial encryption (that is *AIRBAG, *DEFINE_CURVE and *MAT) then 

PRIMER failed to read the file. 
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This was because it thought that there was 'pending' PGP data to be included in those special 

keywords when in fact free-standing PGP data is written to a separate file and should then be 

ignored. 

 

This has now been fixed. 

Explode 

• Case 46847 

If a model was 'exploded' using the 'Connection between includes' method, the edges of parts 

which had been blanked by the process were still being sketched for predictive picking. This has 

been fixed. 

Fmh 

• Case 45569 

The 'Show Target' toggle button in FMH panel now works fine: it draws and clears the target 

marker when turned ON/OFF. 

Formatting 

• Case 46458 

Sometimes, when running LS-OPT with PRIMER integration for morphing within PRIMER, 

LS-OPT could write variables to the design variable file with a number format that the 

'apply_lsopt_variables.js' script (run by PRIMER) could not read. This would result in an error. 

The script has now been updated to account for these number formats and they can now be read. 

Graphics 

• Case 45961 

When performing selection by area PRIMER has an EXT mode which will limit selection to 

only what is actually visible on the screen. (This is not the default, which is to select everything 

in the 'tunnel' through a 3d mesh.) 

 

This was not working correctly for some types of area pick that involved selection of 3d 

elements, or nodes on these elements; typically only a subset of eligible items would be chosen, 

or often nothing at all would be selected. 

 

This was caused by parallelisation of screen picking, and has been fixed by serialising area 

selection when in EXT mode. 
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Iga 

• Case 46097

Previously, part replace would not replace trimming curves, which could result in a crash when 

trying to sketch the trimming curves. Part replacing should work fine now. It should copy 

underlying DEFINE_NURBS_CURVE definition too. 

Integration 

• Case 46893

Corrected minor widget name errors on the LS-DYNA Submission panel. 

Javascript api 

• Case 46823

The JavaScript debugger could fail to terminate the script correctly in some cases when the Kill 

button was pressed. Now fixed. 

• Case 46802

Links to MDN pages on Arraybuffers have been updated. 

• Case 46785

Setting 'x', 'y' or 'z' properties using the SetPoint() method from the Mechanism JavaScript class 

would previously not work correctly, if applied to a 'point' that previously used a node. This has 

now been fixed. 

• Case 46778

The Interface Springback constructor no longer throws errors when more than 8 optional 

arguments are defined. Also the correct values are now assigned to the appropriate fields. 

• Case 46774

In previous versions of PRIMER, a node property specified for the SetPoint() JavaScript method 

for the Mechanism card would incorrectly invoke a *POINT_LOCATION card instead of a 

*POINT_NODE card. This has now been fixed.
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• Case 46228 

The documentation for the Binary property of the Model.Write function was misleading in that it 

implied that the default binary / ascii format is ascii, meaning that if it was undefined the model 

would be written in ascii. 

 

The actual situation behaviour for the binary property is: 

 

true: the entire model will be written in binary 

false: the entire model will be written in ascii 

undefined: each file in the model will be written in the format in which it was originally read. 

 

If this is a newly created model then the default will be ascii. 

• Case 46227 

Part should now show the correct number of beams referred by it. 

• Case 46223 

Parameters should now show the correct number of xrefs for material. 

• Case 46075 

Javascript mass calculation was ignoring the option to include timestep added mass when the 

whole model or include file(s) were flagged for the function MassPropCalc(). This has now been 

fixed. 

• Case 46058 

Regular expressions could fail in JavaScript in version 18.0 (after the JS engine upgrade) with a 

'too much recursion' error. 

This has now been fixed. 

• Case 45823 

If a script that used a graphics drawing function was stopped at a breakpoint in the JavaScript 

debugger error messages could be shown in the dialogue box and an exception thrown. Now 

fixed. 

• Case 34709 

Unicode text could not be used in comboboxes and listboxes. Now fixed. Additionally right and 

centre justification of comboboxes was not correct and has been fixed. 
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Keyword 

• Case 46412 

*DUALCESE_MATERIAL had an empty unnecessary drop down box in the keyword menu. 

This has now been removed. 

Kwd editor 

• Case 46663 

In *DUALCESE_BOUNDARY_XXXXX, all keywords displayed fields of other keyword cards 

as well. This is now fixed. 

• Case 46592 

Giving a zero value to PNODE and a non-zero value to NODEID for 

*CONSTRAINED_NODAL_RIGID_BODY caused a crash in PRIMER. This has now been 

fixed. 

• Case 46221 

While doing 'Select...' from the keyword editor, the editor filters were not honoured. Fixed this. 

• Case 46033 

The keyword editor buttons were getting incorrectly placed for certain keywords like 

*DEFINE_MATERIAL_HISTORIES. Fixed this. 

Manual 

• Case 45801 

PRIMER now opens correct manual pages for Generic Keywords. 

Mass 

• Case 46724 

The mass property tool was not returning the correct value when masses were directly selected if 

these were Element_Mass_Set. Selecting lumped mass worked correctly and using the option to 

include attached mass also worked correctly for both types of mass. This has now been fixed. 

Materials 

• Case 46933 

Timestep for *MAT58 was not being calculated due to errors introduced when support for -ve 

LC for EA, EB was added. Now fixed. 
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• Case 45760 

For *MAT_SEATBELT_2D, FORM has been updated to take integer values. Previously, 

PRIMER would issue an error that FORM was not equal to -14, even though it was, which has 

now been rectified. Also, the warning for CSE when 2D seatbelt is chosen has been updated. 

Mesh 

• Case 46155 

Behaviour of Split predefined mode graphics button and Diagonal split type button in spilt shell 

menu fixed. Previously, the predefined mode graphics button in the Spilt shell menu could 

become unavailable when switching between Split->Shell and Split->Solid. 

• Case 46105 

Primer was crashing when nodes were extruded, specifically which were adjacent to a node 

which is part of another edge. Also, a subset of nodes were extruded if all nodes were selected in 

a particular edge. 

The crash is averted and the bug is fixed. 

• Case 45775 

Previously, Tet mesh would crash when parabolic shells are used 

- fixed this issue. 

Model build 

• Case 46515 

Model build from csv for pedestrian lower legform should now write the z-value to the .lst 

output file. 

• Case 46005 

Impactor positioning (IHI, IPP, PEDHEAD, etc) in Primer 18.0 and previous was performed 

using a contact setup without boxes, irrespective of user's definition. 

If the vehicle side of the contact is very large (in the worst case the exempted parts of the 

impactor) time taken to set up the contact can be considerable. 

In v18.1 the box defined on the contact will be used unless the preference is set to ignore it. 

Multiple jobs 

• Case 45740 

LS-DYNA Submission bookmarks menu in the PRIMER panel would show the non-accessible 

folder options too (could be INSTALL/ADMIN folders). This is now fixed and only the folder 

options that have read/write permissions are shown. 
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Nodal rb 

• Case 46857 

In the nodal rigid body edit menu, previously selected nodes were being drawn when selecting 

new nodes after pressing reset all. This has been fixed. 

Orient 

• Case 46635 

The orient consider INCL_TRANS option was incorrectly disabled if any model in memory 

contained no includes. This restriction is now only applied if the model contains items to be 

oriented. 

Output 

• Case 45914 

In PRIMER 18.0 a spurious (but harmless) error message will be generated during keyword 

output if: 

 

- Keyword auto-promotion is set. (In keyout options #2 panel) 

and 

- The model contains 'child' items such as mechanism assemblies. 

 

There will be an error message about db_ifile_pointer() written to the dialogue window for each 

such child item. It is harmless and can be ignored. 

 

Only present in V18.0, fixed in V18.1 

Part table 

• Case 45964 

When section properties are edited on the part table, if the section is shared by multiple parts, a 

new one is created. This should have the old values copied into it, this copy was unfortunately 

broken by bug fix 33887. Now fixed. 

Pedestrian 

• Case 46798 

Previously, in the Pedestrian Markup tool, PRIMER would incorrectly calculate the upper leg 

impact point angles/velocities/masses for CNCAP protocols via the logic introduced in 

EuroNCAP v8.0. This has now been fixed to use the correct logic outlined in CNCAP 2018. 
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• Case 46203 

In the Pedestrian Markup Tool, when clicking 'Sketch' for the Head Impact points calculated 

using the 'Distance' method after running a GTR protocol, sometimes the script would break. 

This has now been fixed. 

• Case 46168 

Previously, when running the GTR protocol in the Pedestrian Markup tool with the bonnet rear 

reference line (BRRL) selected for calculation, the side reference lines (SRLs) were always 

cropped at the BRRL. If a wrap around distance (WAD) line was further back on the vehicle 

than the BRRL then this could result in the WAD line being cropped inappropriately. This has 

now been fixed such that the SRLs are cropped at either the rearmost WAD line or the BRRL, 

whichever is furthest back on the vehicle. 

• Case 46056 

Made the Pedestrian Markup Tool more reliable. 

• Case 45806 

From EuroNCAP v8.0 and CNCAP 2018 onwards, Child head impact points require an 

alternative impact angle when situated on/in front of the bonnet leading edge. PRIMER 

previously didn't provide the ability to set an alternative impactor orientation angle for these 

points. This has now been fixed - an impactor orientation angle can be set for these points via the 

Bumper (angle) text box on the impact points window of the Pedestrian Impact Markup tool. 

Penetrations 

• Case 45922 

Soft=2 contact on solid segments was giving spurious penetration reports as the wrong thickness 

value was being used. For solid segments this should be zero or SLDTHK. This change does not 

affect the calculation for shell on shell contacts. 

Performance 

• Case 45431 

There was a problem with blanking and feature line edge display which could be triggered as 

follows: 

 

- Blank a 3d part 

- Turn on feature line overlay 

- Edit some part (not necessarily the blanked one) and update it 

- Unblank the part blanked at stage one. 

 

In this scenario the newly unblanked part would have all its edges drawn. This only affected 3d 

parts. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 18.1 
 

Ove Arup and Partners Limited | Final | October 2021  

 

Page 43 
 

 

This has now been fixed. 

Preferences 

• Case 46161 

The preference no_discrete_contouring could previously be set by text-editing the oa_pref file 

but was not listed in the preference tree. This has now been fixed. 

Program crash 

• Case 46699 

Primer could crash when writing a BOM file if a part had the HGID field set but had a SECID 

value 0. Now fixed. 

• Case 46681 

Previous versions of PRIMER could, sometimes, crash when users attempted to edit 

*ICFD_SET cards. This issue has now been fixed. 

• Case 46483 

PRIMER would crash while trying to drag on '0' K1BEG for 

*SET_<XXXX>_GENERATE_INCREMENT - resolved. 

• Case 46479 

PRIMER could crash if you tried to sketch a *SENSOR_DEFINE_MISC card with mtype 

CURVE. Now fixed. 

• Case 46385 

JavaScript can be used to change the part id of elements, and when this is done PRIMER checks 

to see if the elements being changed form part of a connection (*CONNECTION cards). 

 

If they do it makes further checks to see if the change of part id requires related changes to the 

connection and makes these changes automatically. One such situation is when a connection is 

an adhesive in which the 'glue' material is a layer of solid elements: PRIMER requires that all 

elements in a patch of glue be of the same part id, so if one is changed the rest are changed to 

match. 

 

This logic contained an error when some of the 'glue' elements were latent (referenced but 

undefined) since it resulted in these elements changing from not having a part defined to being 

assigned some part id. This caused many problems, including a crash in some graphics 

operations. 

 

Fixed by leaving latent elements with no part id unchanged in this situation. 
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• Case 46253 

Previously, PRIMER would crash when reading a script into the JavaScript Debugger using non-

LATIN-1 encoding. This has now been fixed. 

• Case 46157 

PRIMER would crash when creating a new *SET_<XXX>_GENERATE_INCREMENT by 

creating K1BEG and K1END - resolved. 

• Case 45950 

PRIMER could crash if a script which could not compile because of an error was run more than 

once. Now fixed. 

• Case 44444 

PRIMER could crash when editing and picking nodes for a *DEFINE_COORDINATE_NODES 

card in some rare situations. This has been fixed. 

Program hanging 

• Case 46251 

Using the directory selector could cause PRIMER to hang on Windows 10, versions 2004 and 

newer, unless the file selector was used first. This has now been fixed. 

Ptf compress 

• Case 45574 

If a model contained 2nd order shell elements the Write->ptf/d3plot function produced a corrupt 

d3plot file. This has been fixed. 

Quick pick 

• Case 46126 

Blanking elements by screen area could - rarely - cause a crash. This would be most likely to 

happen with multiple models containing many solids, however it could be unpredictable. 

 

This has now been fixed. 

Read 

• Case 46368 

Layup files containing PATCHID on element line 201 could not be read by PRIMER. Now 

fixed. 
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• Case 45957 

Changed the way we check extensions for drag and drop case. Now, except for the special 

extensions like .jt, .inp, etc, everything will be read as a LS-DYNA keyword file. 

Renumber 

• Case 46640 

The order of file names written out in CSV files will now match the order of the include files in 

the Renumber Includes panel. 

Rigidify 

• Case 46586 

There was a crash when writing out a model after a rigidify process. This has now been fixed. 

Scripting 

• Case 46048 

When running Dummy_Finger_Assembly_Creation_Script.js in PRIMER 18.0, a warning 

message would be issued. This caused a problem as the script uses macros to create the new 

assemblies. 

This has been fixed now. 

Seatsquash 

• Case 46513 

While positioning the Seat and Dummies using the 'Seatsquash and Dummy' tool in PRIMER, 

the selected dummy parts to be kept deformable were not being honoured. Fixed this. 

Sets 

• Case 46516 

PRIMER assumed that setting an increment of zero on the 

*SET_XXX_LIST_GENERATE_INCREMENT keyword meant nothing should be added to the 

set. 

 

However, LS-DYNA silently changes this to an increment of 1. PRIMER has been updated to 

mimic this. 
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• Case 44705 

Any node on *INITIAL_TIED_CONTACT_DATA keyword was flagging other nodes when 

selected for a Node SET. This caused extra nodes that were not selected to get added to the Node 

SET. This has been corrected now. 

User interface 

• Case 46025 

There were some inconsistencies with the colours of buttons used to add and remove optional 

cards for some keywords. This has now been made consistent. 

• Case 45960 

Seatbelts -> Fit - yellow “x” for *DATABASE_CROSS_SECTION changed to red-orange. 

Utilities 

• Case 44539 

*INITIAL_FOAM_REFRENCE_GEOMETRY Create option was not working when multiple 

models are loaded in PRIMER. Fixed this. 

Write 

• Case 46360 

Open ended cards for the *DEFINE_QUASAR_COUPLING were being written out for pre R13 

versions. Fixed this. 

• Case 46095 

On *CONTROL_IMPLICIT_SOLVER when card 2 was left with default zero values, Card 3 

was written as card 2, this has been fixed. 
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2.2 D3PLOT 

2.2.1 Bugs Fixed in 18.0 

Animation 

• Case 45311 

If an image or movie was written out of D3PLOT and it contained Shell element parts which 

were being drawn using the option to display them with their thickness, then those parts could be 

missing from the image. The problem would only occur if the parts were either being cut by a cut 

section or if only a subset of the elements in the part were being drawn. 

• Case 45156 

The default frame rate when writing Movies has been changed to 25 fps. This value can be 

controlled using the new d3plot*output_frame_rate preference. 

• Case 44413 

The version of FFmpeg used by D3PLOT (and now also REPORTER) has been updated to 4.3.1. 

• Case 45389 

If a movie file of a contoured model was exported without having already manually animated the 

model, the contours could be scanned with data scan set to first/last (i.e. the max/min values 

calculated based on the first and last frames only). If the data values in intermediate frames fell 

outside the first/last frame max/min, then the contour bar values in the movie file would not be 

correct. This has been fixed. 

Attached 

• Case 44961 

In the dialogue command Attached menu a new option has been added for Rigid Parts to swap 

between unblanking single elements or the whole part.  

 

Previously this option existed in the GUI, but the dialogue command options only had an option 

for controlling the behaviour in deformable parts.  

 

The four options for single/whole parts in rigid/deformable are now: 

 

/attached selection single_elem  

/attached selection attached_part  

/attached rigid_selection single_elem  

/attached rigid_selection attached_part  

 

(the first two already existed and are unchanged) 
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• Case 43978 

If the recursive option was used in the Attached menu, then D3PLOT would track across deleted 

elements and find flying unattached elements. 

 

In D3PLOT 18.0 the recursive option no longer tracks across deleted elements unless the user 

has turned on the option to draw deleted elements. 

• Case 43446 

In previous releases, Attached worked on a per-model basis and this meant that if a model was in 

multiple windows with different entities blanked in each window, the effect of an Attached 

operation was to unblank the same elements in all windows. 

In D3PLOT 18.0 the Attached menu has been modified so that it now has window tabs instead of 

model tabs when multiple windows are active. The Attached operation now works on a per-

window basis. 

Blanking 

• Case 45152 

If you used the Quick Pick ‘Key In’ option to try and blank any of the Multiphysics Parts then 

nothing happened. Now fixed. 

Contacts 

• Case 41558 

The order in which contact surfaces appear on the XY data panel has been changed. Previously, 

the slave surfaces were followed by all master surfaces:  

 

Slave 1  

Slave 2  

Slave 3  

Master 1  

Master 2  

Master 3  

 

Now slave and master for the same contact are paired like so:  

 

Slave 1  

Master 1  

Slave 2  

Master 2  

Slave 3  

Master 3 
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Contour 

• Case 45540 

If the option to plot data relative to a reference node was turned on while a reference state was 

also set, then the values displayed could have been incorrect. This has been corrected. 

• Case 45381 

When D3PLOT calculates the contour bar range for SI, CT or LC plots then by default, it only 

includes the values from external visible faces of 3D elements. To include the values from 

internal faces, you previously had to switch on the drawing of internal faces.  

 

From version 18.0 onwards D3PLOT has a new option in the Data menu. If selected, D3PLOT 

will include the internal faces when calculating the contour bar range without having to switch 

on the drawing of internal faces.  

 

For backwards compatibility, the default in D3PLOT 18.0 is still to use just the external visible 

faces but this can be changed via a new preference option, d3plot*contour_bar_3d_faces. 

• Case 44007 

If a contour plot with limiting values was created, then any entity types for which the component 

was invalid were drawn as uncontoured (grey) items, even if the user had selected the ‘omit’ 

option. In D3PLOT 18.0, this behaviour has been changed so that by default, uncontoured items 

are not displayed when the limiting values ‘omit’ option is selected.  

 

A new option has also been added to the limiting values menu to switch off the new behaviour 

and to revert to the previous logic if preferred. 

• Case 43610 

If some items had the display mode changed from ‘Current’ to ‘Shaded’ then when Auto 

Transparency was used, those items would be drawn opaque and the transparency level applied 

to uncontoured items wouldn’t be applied to them.  

 

D3PLOT 18.0 has a new option which can be used to apply the uncontoured transparency value 

to Shaded items. The default is the same as in previous versions so that Shaded items are still 

drawn opaque, but the Auto Transparency menu now has a new option, “Treat Shaded as 

Uncontoured”, which applies the transparency to the Shaded parts as well. 

Cut section 

• Case 45071 

The JS API function GetCutForces sometimes returned incorrect values when used in a D3PLOT 

session started from the command line with -d=tty. This has now been fixed. 
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• Case 44978 

D3PLOT would report the wrong cut section forces if a cut section was defined when magnified 

displacements were also set.  

 

In D3PLOT 18.0 this has been fixed if the cut section has been defined using BASIC space.  

 

When DEFORMED space is used it is not possible to calculate the forces within D3PLOT, so 

D3PLOT 18.0 now checks for the combination of DEFORMED space and Magnify 

displacements and, if they are both set, it refuses to calculate the forces and displays a warning 

message telling the user why they have not be calculated. 

• Case 44728 

When switching on multiple parallel cut planes (with uniform spacing) via a dialogue command 

and then changing the spacing to a smaller number, D3PLOT would sometimes continue to draw 

the (smaller) number of planes relevant for the larger spacing. Now the number of cut planes 

drawn updates correctly. 

• Case 44189 

The drawing of the intersection of warped quadrilateral faces with cut planes has been improved. 

• Case 44152 

Cut planes intersecting warped quadrilateral shells can have all four edges intersecting the plane. 

D3PLOT now correctly draws two capping line segments on these shells, rather than one. 

Data components 

• Case 43193 

Fixed an issue where the button that normally displays ‘Vel’ would read ‘???’ when Volume 3 

analysis results were opened in D3PLOT. 

Dialogue command 

• Case 45134 

Fixed an issue where the AVI_READ dialogue command would crash if passed a filename to a 

non-existent file. The AVI_READ and AVI_DISPLAY commands are now deprecated in favour 

of MOVIE_READ and MOVIE_DISPLAY following the addition of MP4 support to D3PLOT. 

• Case 45069 

Some dialogue commands for beam properties caused D3PLOT to crash. Now fixed. 
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• Case 44678 

Fixed an issue that caused D3PLOT to crash if the dialogue command to set user-defined contour 

levels was entered as a single line. 

Filtering 

• Case 38357 

When selecting all visible items with All_Vis from an object menu, text filters were not 

respected, so items not displayed on the menu due to the filter were also selected. Now, only 

items on the list are selected. 

General 

• Case 44530 

If a model contained both SPCs and either NRBs or Loads, and if PRIMER had created a ZTF 

file, then the internal numbering of the NRBs and Loads was incorrect if SPC forces has been 

written out to a LSDA (binout) file. 

 

This error would result in the incorrect entity types being reported as being connected to nodes 

which should have had SPCs on them (as shown in the write table when listing connected 

elements). It also meant that using the Attached menu to find items attached across NRBs didn't 

work correctly. This has now been fixed. 

Graphics 

• Case 44989 

For a faded background colour, the option to use Auto was not working in D3PLOT 17. It is now 

fixed. 

• Case 44988 

In a colour popup, if you create a new colour, you now see it applied immediately.  

 

In the Part Tree or when using Quick Pick, when selecting a single item to change the colour and 

create a new colour, then the colour palette is initialised as the current item colour (instead of 

black). 

Image 

• Case 45363 

D3PLOT has an option to capture image files at 2× and 4× screen resolution. On Linux, when 

the Window Dressing options to clip the image to a sub-set of the screen (e.g. 'Part screen', 
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'Report format') were used, the resulting image had a superimposed grid of horizontal and 

vertical stripes. Now fixed. 

Integration 

• Case 45636 

REPORTER templates containing a mixture of D3PLOT and T/HIS items could cause a crash if 

generated in a D3PLOT session linked with T/HIS rather than in separate D3PLOT and T/HIS 

sessions. This has been fixed. 

• Case 44494 

If a composite part had an even number of layers and data was plotted using the 'Min/Max/Mag 

All' option for one of the Extra time history variables, then the plot could incorrectly show 0 for 

those elements. This has now been fixed. 

JavaScript API 

• Case 45532 

D3PLOT could crash if a JavaScript was run multiple times without any model loaded. Now 

fixed. 

Labels 

• Case 45466 

The label font size at maximum and minimum contour values was not updated correctly when 

the List option was not selected on the Max & Min options in the Data menu. Now the font size 

updates correctly. 

Materials 

• Case 44493 

If data was plotted on composite parts for one of the Extra time history variables, then everything 

worked correctly if the surface was changed to one of the 'Min/Max/Mag All' options.  

 

If the same data was plotted by selecting the component via the Material Properties data 

component category, then the 'Min/Max/Mag All' options could report incorrect values.  

This has now been fixed. 
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Menus 

• Case 45201 

In D3PLOT 17.1, reading a settings file would cause the user colours to be modified. In 

D3PLOT 18.0, the user colours remain determined by the user_colours.xml file. 

• Case 44392 

When running REPORTER with a linked D3PLOT-T/HIS session, the Variables panel 

sometimes failed to update and move any newly created variables to the list of existing variables 

when the capture was updated. Now fixed. 

Part Tree 

• Case 45015 

Fixed an issue where the colour popup could appear stranded when its parent menu closed. 

Preferences 

• Case 43800 

Fixed an issue where D3PLOT was not applying locking to startup preferences (like 

graphics_type, maximise). 

• Case 43742 

When running D3PLOT with the command line option -pref=/xxx/yyy/custom_pref, if the 

preference 'script_dir' was used in 'custom_pref', the setting got lost and the scripts did not 

appear on the tree. Now fixed. 

Program crash 

• Case 45658 

D3PLOT could crash when picking a part in a window containing multiple models, one of which 

contained no solid or thick shell elements. This has been fixed. 

• Case 45539 

D3PLOT could crash when writing out *INITIAL_STRESS_BEAM cards if the model 

contained Belytschko-Schwer beams and the PTF files did not contain all of the output data 

required for Belytschko-Schwer beams. Now fixed. 

• Case 45200 

D3PLOT could crash when reading back in a d3plot/.ptf file that had been created using the 

Cutdown/Compress option from within D3PLOT, if the file was written in the re-ordered format 
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and the ZTF file was embedded within the file.  

 

The crash would occur if the cut-down model only contained a subset of the original parts and 

contained spotweld assemblies that referenced elements in parts that had not been output to the 

file. This has now been fixed. 

Properties 

• Case 45549 

In the Properties menu, the settings for the entity and label switches were not copied across to 

other models when 'All Properties' were exported. Now fixed. 

Read 

• Case 45657 

When a model was reopened (File → Reread model) the current plotting mode would initially 

revert to shaded, swapping to the current mode (e.g. SI) only when the mouse was hovered over 

it, triggering a Predictive Pick redraw.  

 

Now fixed: The original plotting mode is remembered and reused immediately when a model is 

reread. 

• Case 45281 

Fixed an issue where D3PLOT could appear to hang for some time when reading in a model 

while displaying the following message: Computing quick draw list in family 0  

• Case 43854 

In the 'Multiple Models (Search Directories)' the file type filters sometimes filtered by the wrong 

type when opening a new model. For example, when D3SSD files were selected, the bottom of 

the panel actually showed D3EIGV files. This has now been fixed. 

Sections 

• Case 44867 

True beam sections in D3PLOT were not always drawn consistently with those in PRIMER and 

the LS-DYNA keyword manual. For ICST = 5 on the *INTEGRATION_BEAM card the 

drawing in D3PLOT 18.0 has now been changed from a solid box to a tubular one. 

Session 

• Case 44640 

If multiple copies of D3PLOT were started by the same user on the same machine and they all 

used the options to save or restore session files then things could go wrong as they would try to 
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use temporary files with the same filenames.  

 

From D3PLOT 18.0 onwards, each occurrence of D3PLOT creates unique pathnames for any 

temporary files. In addition, D3PLOT 18.0 will tidy up and remove these temporary files when it 

has finished with them or if the user exists D3PLOT. 

• Case 44312 

If a session file was opened in D3PLOT by double-clicking on it and some of the models it 

referenced were unavailable then the Apply button was still active and would generate error 

messages if you clicked it. Now fixed. 

Settings file 

• Case 45361 

If a settings file was written out that included measurements that had been defined using a 

reference state, then when the settings file was reloaded the relative state was not re-applied to 

the measurement. Now fixed. 

• Case 45360 

If 'Traces' were setup in D3PLOT and a settings and properties file were then written out, the 

'Traces' were not restored when the files were read back into another session. Now fixed. 

• Case 45010 

If you read a settings file from D3PLOT 16.1 or earlier where the overlay colour was set to 

'element', it came out violet. This has now been fixed and it comes out 'element' colour as 

expected. 

Shortcut 

• Case 44725 

Corrected 'w' shortcut key processing to open the Images panel on the Raytrace tab if that was 

the last one accessed in a session. 

User interface 

• Case 45653 

When D3PLOT or T/HIS were linked to REPORTER in shared memory mode the item tree 

would not necessarily update to include a vertical slider when the contents extended beyond the 

bottom of the item tree box. This has been fixed. 
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• Case 45373 

In a linked D3PLOT-T/HIS session, if a graph was changed from child to sibling or vice-versa 

then 'Bad window id in: 0' error messages would be displayed and the REPORTER Panel could 

be displayed in D3PLOT. This has been fixed. 

• Case 43674 

The ‘Select None’ text now fits in the button in the Write Table panel in the new UI. 

• Case 43641 

Adjusted scaling of object menus in D3PLOT so text fits on the Scr_Area button in the new UI. 

• Case 43460 

The colour of Window and Model tabs was not changing when hovering over them. Now fixed. 

• Case 43410 

Yellow and dark blue colours in the key of the FLD graph were not readable in light and dark 

themes respectively. Changed to dark orange and olive, which are readable in all themes. 

• Case 42503 

The button text 'Tools' on the T/HIS link button has been changed to 'T/HIS'. It now only says 

'Tools' when the T/HIS link is actually open and the T/HIS tools buttons are shown. 

Views 

• Case 44545 

If a window contained multiple models and perspective viewing was switched on, then the 

options in the GUI to modify the perspective settings were not applied and the view did not 

update. Now fixed. 

Write 

• Case 45086 

If a new model was opened in D3PLOT while the Write Keyword menu was open, then the 

menu was closed as normal, but when it is subsequently re-opened, the Model tabs were not 

displayed and the terminal window showed some error messages. Now fixed. 

• Case 44082 

If a model was loaded into multiple windows then the 'Write Keyword', Write Scan' and 'Write 

Global' menus always used the first window that the model was displayed in when extracting 

data.  
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In these menus which use model tabs D3PLOT 18.0 has a new option that allows you to select 

which window is used when extracting data.  

 

If a model appears in more than one window, then by default the first window containing the 

model is used (same behaviour as previous versions), but a popup menu is activated that allows 

you to select any of the other windows that the model is also in.  

 

Beside the popup (which shows the currently selected Window) the state time for the selected 

window is also displayed to make it more obvious which state data will be extracted from.  

 

In SCAN mode, if you have selected multiple states via the 'Envelope' option then the popup is 

disabled and the time display unmapped. 

XY Data 

• Case 45626 

Fixed an issue where outputting an XY Data composite graph for an element type other than 

solid elements, if multiple element types present in the model, would generate incorrect data. 
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2.2.2 Bugs Fixed in 18.1 

Airbag 

• Case 46781 

D3PLOT can calculate the averaged airbag particle velocity in a cell and display it as a vector 

plot. If you chose to ‘smooth’ data over adjacent cells, then this was not displayed correctly in 

vector plots which instead continued to use the raw per-cell data. Now fixed. 

Animation 

• Case 46849 

When animating models with a delay – of one frame per second, for example – the window 

slider could be one frame ahead of the graphics. If multiple windows were animated the window 

slider in W1 could be one frame ahead of the other windows. Now fixed. 

• Case 46614 

If a velocity plot was animated the arrows were drawn correctly the first time (while the 

animation was being created) but after that, the arrows stayed fixed and did not change from 

state to state as the animation played. Now fixed. 

Blanking 

• Case 46500 

Fixed a crash that could occur if a movie or image background was read in and moved to a 

separate window, and if you then used one of the object menus (e.g. the blank menu) and 

hovered over an item in the menu to sketch it. 

Command files 

• Case 46598 

Added a preference d3plot*show_all_components to show all possible data components on the 

popups in the Write and XY Data menus. With this preference set, the components not available 

are greyed out (as in the Data menu) rather than omitted. 

Contour 

• Case 46055 

Fixed a crash that could occur when contouring a model containing solid elements with a 

reference state from another model containing a different number of solid elements. 
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• Case 44178 

Fixed an issue where velocity arrows were occasionally not displayed if the user clicked the VEL 

button directly after having done a CT, SI or LC contour plot. 

Cut section 

• Case 46525 

When a cut section was passing through undeformed geometry, the intersection of the plane with 

the undeformed position of shells was drawn twice on top of each other in different colours. Now 

it is only drawn once as dashed lines in the colour of the undeformed geometry. 

• Case 46501 

Cut section end caps on shells did not respect the NLOC values of underlying sections. 

Previously they were always drawn with the nodes on the middle surface, where now they 

appear on the top or bottom surface depending on NLOC. This is consistent with the drawing of 

shells with true thickness. 

• Case 46387 

Cut section 2D capping thicknesses can either be based on true shell thickness or on a fixed 

thickness. For models with no thickness data available D3PLOT always uses a fixed thickness. 

When a graphics window contained two models, where one had got thickness data and the other 

one had not, then the cut section would have been drawn incorrectly with a fixed thickness for 

both models in D3PLOT 18.0 even when the option to use true thicknesses was selected. Now 

D3PLOT draws the cut section correctly with true thickness in the model having it and with a 

fixed thickness only in the model without thickness data. 

• Case 45999 

When dragging a cut plane defined by three nodes either as translation or as rotation, the cut 

section panel continued to show it as defined by three nodes although in general the plane will no 

longer pass through these nodes. Now it reverts to a definition by origin and vectors similarly to 

the case of rotating a plane with constant X, Y or Z. The panel is now updated correctly. 

D3PLOT Viewer 

• Case 46435 

3D Viewer Export has been renamed to D3PLOT Viewer. A D3PLOT Viewer button has been 

added to the D3PLOT Viewer panel to launch the D3PLOT Viewer web page. Additional help 

has been added to D3PLOT Viewer file format to explain compatibility with PowerPoint and 

other viewers. 
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• Case 46336 

Specifying GLB contour output for a single component at multiple through-thickness integration 

points on the command line resulted in all results being written to the same filename which was 

overwritten for each through-thickness integration point. This has been fixed. 

• Case 46334 

A model with only undeformed geometry could not be exported to 3D viewer format and did not 

give any warning message. This has been fixed. 

• Case 46775 

If a GLB file was created using the command line ‘-glb’ option then it was always created using 

the uncompressed format. 

 

This has been changed in 18.1 so that the ‘-glb’ option now creates a compressed GLB file and a 

new ‘-glb_uncompressed’ option has been added to create uncompressed files. 

Dialogue command 

• Case 46555 

The dialogue commands /XY_DATA GLOBAL and /WRITE GLOBAL were not working. Now 

fixed. 

Error trapping 

• Case 46750 

If user created Wn (window n) containing two or more models, deleted Wn and then recreated 

Wn containing only one model, then an error message was printed to the dialog box. This has 

been fixed. 

• Case 46446 

If multiple windows were closed and then a window was opened, D3PLOT could generate an 

error message ‘Unused window id in <set_active_window>:’. This has been fixed. 

FEMZIP 

• Case 46695 

D3PLOT misread a results file in which both solid and shell elements were present, but results 

were only written for shells. 

 

It opened the file OK and animated the geometry correctly, but as soon as results were plotted 

errors were generated. In addition the file only contained plastic strain and an ‘extra’ shell data 

component, but D3PLOT offered stress tensor data components for plotting. 
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This was because it was decoding the control block of the file incorrectly, leading it to expect 

stress and strain results for solids, meaning that the data in the file was misinterpreted. The file in 

question was a FEMZIP file, which meant that the error looked like a FEMZIP reader failure, but 

in fact the error would have been present for a plain file as well. 

 

Fixed by correcting the error in interpretation of the control block. 

Graphics 

• Case 46872 

In D3PLOT 18.0, each change to an option on the Entities panel would cause the last active 

graphics window to update based on that change, but no other windows would update. This 

could cause slow behaviour if the user wanted to change multiple options, as each would update 

the window individually. Plus, other windows would not see this change until later. Now 

D3PLOT waits until the user has set all the options they want before updating the windows. It 

also updates all active windows at once. 

• Case 46855 

In D3PLOT 18.0, if multiple models were loaded into a window and a velocity vector plot was 

generated then in some situations, the velocity vector arrows were not displayed on some 

models. Now fixed. 

Integration 

• Case 46776 

PRIMER could fail to find a model when opened from a D3PLOT session with more than one 

model. This has been fixed. 

JavaScript API 

• Case 46653 

There were the following errors in the JavaScript interface for cut sections: 

For cut sections defined by constant X, Y or Z given by a node, the object returned from 

GetCutSection contained that node in nodes[1]. Now that node is correctly returned in nodes[0] 

(as stated by the API documentation). 

For cuts defined by constant X, Y or Z with node ID or by 3 nodes, D3PLOT only worked when 

the nodes were specified by negative label, but crashed for a positive index. This has now been 

fixed. 

For cuts defined by Origin and Vectors, the vectors were scaled unexpectedly. They are now 

correctly normalised to unit length. 
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Movies 

• Case 46883 

Fixed a possible crash when capturing MPEG-1 content at high resolution (4k). 

Performance 

• Case 46204 

D3PLOT could run slower after properties, e.g. colour, were changed by include. This has been 

fixed. 

Program crash 

• Case 46585 

Capturing windows with ICFD components contoured to REPORTER could cause D3PLOT to 

crash. This has been fixed. 

• Case 46562 

D3PLOT could crash if used with a 3D mouse and a machine running more than 8 threads. This 

has been fixed. 

• Case 46434 

D3PLOT could crash if you opened multiple windows, plotted an envelope plot, closed a 

window, and then created a window, either by opening a new model or via Window → New 

Window. This has been fixed. 

• Case 45817 

If a model containing shell elements was contoured with a reference state from a different model, 

then D3PLOT could crash. This has been fixed. 

• Case 43102 

T/HIS crashed when displaying a very long directory name as a prefix. Now fixed. 

Properties 

• Case 46384 

In a D3PLOT session with multiple windows linked to PRIMER and with all the models in a 

window blanked – e.g. when an extra window has been opened to display a movie background – 

blanking a part in D3PLOT could result in the view changing. This has been fixed. 
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• Case 46175 

On the top-level Properties panel, setting the colour of all entities of a given type, for example all 

parts, did not work. This has been fixed. 

Quick Pick 

• Case 45753 

If the Quick Pick Type was changed to ‘Entities’ then the ‘Key in’ option wouldn’t work, 

because an entity type prefix had to be specified (e.g. S10 to blank Shell ID 10) but the ‘Key in’ 

text box generated an error message if you made a non-numeric entry. If you entered the ID 

without the entity type prefix, then a different error message was generated, because the entity 

type had not been specified. Now fixed. 

Read 

• Case 45809 

If multiple models were opened from a database file with the option to open all models in a 

single window selected, the option would be ignored and the models opened in separate 

windows. This has been fixed. 

Selection 

• Case 45973 

In D3PLOT 18.0 (but not in earlier versions), if T/HIS link was open and you tried to select 

entities for reading data into T/HIS by selecting ‘Pick Visible’ and dragging a box around the 

entities in the D3PLOT window, then D3PLOT could crash. This has been fixed. 

Session 

• Case 46447 

If T/HIS was opened from D3PLOT and a session file was saved, reloading the session file 

wouldn’t reload curves that had been blanked. This has been fixed. 

• Case 45979 

Writing a session file for a D3PLOT ↔ T/HIS link session may have caused D3PLOT to crash. 

This has been fixed. 
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Settings file 

• Case 46808 

If a settings file was created and then read back into D3PLOT where a window contained 

multiple models, then the data blocks containing settings for external ‘blob’ plot data were not 

read correctly and could cause an internal memory overwrite of other settings in the D3PLOT 

session. Now fixed. 

Sketch 

• Case 46120 

Fixed a crash that could occur if you had multiple models open, and when you hovered over a 

part in an Object menu and D3PLOT tried to sketch the part. 

Streamlines 

• Case 46874 

When data plotting on streamlines, if you changed from calculation by ICV Fluid velocity to 

ICV Average velocity, and then hovered over the model, the max/min values plotted on the 

model would update, but the contour bar may not have updated, resulting in a mismatch between 

the max/min values on the model and on the contour bar. This has been fixed. 

T/HIS link 

• Case 46755 

It was possible to select graphs to export as GLBs for D3PLOT Viewer when the D3PLOT-

T/HIS link was active, but these are not suitable to export in this way, so D3PLOT could behave 

inconsistently. It is now no longer possible to select graphs from the menu. 

User interface 

• Case 46532 

The Ray Tracing and D3PLOT Viewer tabs of the Images/Movies Export panel can now be 

accessed via Quick Find. 

• Case 43964 

In version 17 and 18.0 of D3PLOT, if the user clicked and released the mouse button quickly on 

the button to display the list of database component categories, the menu would automatically 

select the first component in the category that the mouse was over when the popup appeared. In 

most cases this would select a component in the ‘Shell Resultants’ category. 

In version 18.1 onwards, the behaviour has been changed to stop the data component from being 

accidentally changed. 
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User defined 

• Case 44440 

When plotting user-defined data from .ubd files, if the user had the ubd_file_location preference 

set and valid data in the directory it was pointing to, but also valid data in the model’s directory, 

data would be set to 0 for all states. 

 

Now, D3PLOT will only read .ubd files from one location: the preference location if it is set, 

otherwise from the model directory. If D3PLOT reads data from the preference location and also 

detects data in the model directory, the user will be warned that this data will not be available in 

the current session and be told how to access it in another session. 

Variables 

• Case 46453 

In D3PLOT linked to REPORTER (version 17.0 onwards) the ‘+’ button in the REPORTER 

Panel variables list remained active even when all the possible variables had been defined and if 

pressed resulted in a warning about unsaved variables when user changed item. Now the ‘+’ 

button is only shown if some possible variables have not yet been added to the item. 

Write 

• Case 46094 

Nodal data values for element data components, e.g. X direct stress, for nodes connected to solid 

elements with multiple integration points in WRITE, XY-DATA and Quick Pick → Dynamic 

Label → Data Value, were calculated incorrectly. This bug did not affect contouring. This has 

been fixed. 

XY Data 

• Case 46612 

If XY Data was used to extract strain-based data components for Thick Shells and the 

MIN/MAX/MAG all option was used, then the curves generated could be wrong and were 

sometimes displayed as a constant value of 1.0. Now fixed.  
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2.3 T/HIS 

2.3.1 Bugs Fixed in 18.0 

Annotation 

• Case 45538 

Annotations in the Measure menu did not show x- and y-values. This has been fixed. 

Curve table 

• Case 44423 

If the contents of the curve table were written out to a CSV or XLXS file and the curve table was 

displaying injury criteria, then any lines containing the model summary incorrectly showed zero 

for the injury criteria where they should have shown '-' for the values that did not apply. Now 

fixed. 

Curves 

• Case 45254 

If you displayed the history for a curve in T/HIS and tried to delete the last operation used to 

create the curve, then when you clicked on 'Update Curve', the curve was rebuilt as it originally 

was with the last operation still being applied. This has now been fixed. 

• Case 45223 

A crash could occur after deleting curves with annotations. This has been fixed. 

Dialogue command 

• Case 43433 

Added StartTHisLink() and ExitTHisLink() JS API functions to D3PLOT. You can now open 

and start the T/HIS link via JavaScript.  

 

These have been added to replace the use of DialogueInput() which was previously not able to 

open the link correctly when a JavaScript Window was open. This bug should now also be fixed, 

although it is recommended to use the new functions mentioned above for this purpose. 
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FAST-TCF 

• Case 45265 

A FAST-TCF script could extract data from the wrong in-plane (or solid) integration point if the 

script contained multiple read commands where the first command did not specify an integration 

point and the second one did. Now fixed. 

• Case 43419 

If an airbag and airbag part both had names, then if the option to write names in place of entity 

IDs into FAST-TCF scripts was switched on (this is the case by default), then FAST-TCF Read 

commands for airbag part data would not be processed correctly. This has been fixed. 

Menus 

• Case 45228 

Previously, if you selected a user-defined colour for your title or axis, it changed on the graph, 

but did not show as changed in the menu. This has been fixed. 

• Case 45108 

In some circumstances, if the option to select models was changed to 'Search Directories', then in 

the panel that lists the models, the buttons used to select the models were too small and did not 

display any text. This has been fixed. 

• Case 44118 

On Windows, the sequence: 

- Move mouse into menu of items  

- Let it auto-expand  

- Move mouse over button at top of menu  

could cause the 'Hover over lighting up' of the button to display in the wrong place, typically 

near the top of the scrollable list of menu items. Now fixed. 

Preferences 

• Case 43799 

T/HIS was not applying locking to startup preferences (like graphics_type, maximise). Now 

fixed. 
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Properties 

• Case 44502 

Fixed an issue where FAST-TCF curve legend properties for the minimum and maximum Y-

values were not being correctly read into T/HIS. 

Read 

• Case 45476 

For Volume 3 ASCII files (CESE, ICFD, EM) with the format of file_name_xxx.dat or 

file_name.xxxx.dat, if you read more than 100 files, errors would pop up in the dialogue window. 

Now fixed. 

• Case 45346 

T/HIS could sometimes crash if it attempted to read data from an LSDA (binout) file on a remote 

disk system while an LS-DYNA analysis creating the LSDA file was still running. In T/HIS 18.0 

some changes have been made to improve reliability. 

• Case 45240 

Some BINOUT files produced by beta versions of LS-DYNA R12.1 were displayed in T/HIS 

with the X-axis unit set to 'Frequency' instead of 'Time'. Now fixed. 

• Case 44589 

T/HIS failed to read a CSV with an extra comma and white space at the end of each line. Now 

fixed. 

Session 

• Case 44639 

If multiple copies of T/HIS were started by the same user on the same machine and they all used 

the options to save or restore session files, then things could go wrong as they would try to use 

temporary files with the same filenames.  

 

From T/HIS 18.0 onwards, each occurrence of T/HIS creates unique pathnames for any 

temporary files. In addition, T/HIS 18.0 will tidy up and remove these temporary files when it 

has finished with them or if the user exists T/HIS. 

• Case 42795 

If a session file was saved for a D3PLOT-T/HIS linked session where curves had been sent to 

T/HIS from D3PLOT, then the model number, entity type and entity ID for the curves were not 

recorded in the session file. This meant that when the session was re-opened the curves were 
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created correctly, but they were not assigned to the correct model and the entity type and ID 

were not set. Now fixed. 

Speed 

• Case 45462 

A JavaScript that performed operations on many curves was slower in T/HIS 17 than in T/HIS 

16. Now T/HIS 18.0 no longer updates the Curve Manager menu while a JavaScript is running. 

If the JavaScript is interactive, e.g. uses curve picking, or is run from the debugger, the curve 

manager menu will be updated. This behaviour can be changed by setting the new preference 

this*javascript_update_curve_menu to TRUE instead of FALSE (the default). 

User interface 

• Case 45409 

In the Read panel, a new 'Read Models' subheading was added to make it easier to find the New 

Model and other related buttons. 

• Case 45393 

Adjusted the 'Edit in PRIMER' popup to be more readable across a wider range of screen 

dimensions and display settings. 

• Case 45035 

The Read and Generate X Values buttons in the CSV menu have been changed to radio buttons 

and function accordingly. 

• Case 44827 

Fixed an issue where the Operate output curve selection menu would become disabled for the 

remainder of the T/HIS session. 

• Case 44812 

Fixed an issue whereby the Graph Toolbar 'Auto Hide' functionality did not persist when re-

reading and 'Extracting to match' curves. 

• Case 44503 

Fixed the Y Max and Y Min curve property tick boxes from unintentionally changing into a 

mixed state colour when the Highlight and Display text options have both been turned on. 

• Case 44319 

A slider was added to the Select Int Points and Node panel for better operation on smaller 

screens. 
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• Case 43691 

The colours in the curve History buttons had been lost in the new UI. Now, the buttons are blue 

when modified and green when inserted. 

• Case 43479 

T/HIS Keyboard input was white text in the Light theme, making it very difficult to read. 

Changed so that the text input is now the same colour as the regular dialogue input. 

• Case 43212 

Under certain situations on Linux, while trying to save out an image or curve file without 

specifying the file extension, it would not be added to the final filename. Now fixed. 
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2.3.2 Bugs Fixed in 18.1 

Curve menu 

• Case 46343 

The curve number button will no longer be greyed out for the last curve if it is copied and 

inserted above. 

Curve table 

• Case 46557 

If multiple models are read into T/HIS, then by default T/HIS automatically adds a prefix to the 

curve labels containing the model number (M#). 

 

If the HOME key was pressed in the textbox displaying a curves label in the Curve Manager 

menu, then the cursor would move to the start of the prefix (which can’t be edited) and not the 

start of curves label. You were then unable to type anything into the curve label textbox. 

 

A similar problem would occur if you clicked in the textbox and the used the left arrow key to 

move the cursor left into the prefix text. 

These issues have now been fixed. 

Curves 

• Case 46245 

Line width is now preserved when reading in .cur files. 

Edit 

• Case 46871 

When editing a curve using the Edit panel, if you right-clicked on the curve in the graphics 

window and press ‘Locate’, seemingly nothing happened. 

 

In T/HIS 18.1 onwards, the list of points in the Edit menu is now scrolled so that the selected 

point in the curve is in the middle of the range of points displayed. 

FAST-TCF 

• Case 47020 

If a FAST-TCF script was run multiple times (or multiple different FAST-TCF scripts were run) 

and they used the option to define a curve via an equation, then T/HIS could sometimes crash. 

Now fixed. 
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• Case 46947 

When attempting to write out a FAST-TCF file when equations that contained Maths functions 

with the letter 'c' (e.g. cos(x) or csc(x)) have been created in the session, the 'c' in the math 

formula command was omitted from the FAST-TCF file. This has been fixed. 

• Case 46810 

Fixed an issue where User Equations generated from FAST-TCF were not being correctly 

ordered upon playback completion. 

• Case 46531 

The FAST-TCF variable $run_name only got set if the model keyword file had a *.key 

extension. It will now get set if it has a *.key or *.k extension. 

• Case 45601 

Fixed a bug where FAST-TCF generation was not correctly uncommenting label commands 

when curve labels were manually edited. 

• Case 41318 

When opening a model in T/HIS, if the option to automatically extract curves to match those 

already read from another model was used, then the curve labels for any curves that had been 

created by a curve operation showed incorrect curve numbers used to create the curve. Now 

fixed. 

JavaScript API 

• Case 46328 

We have added functionality to all Read class functions in the T/HIS JavaScript API so that you 

are now able to specify the output option. For instance, being able to specify that a file will begin 

reading into Curve 5, or by Highest+1 and read sequentially from that point for files containing 

multiple curves. 

 

The following functions have been deprecated and optional arguments on the old functions have 

been collapsed into an object with equivalent object properties into a new function of the same 

name. Support for the deprecated versions of these functions may be removed in future releases: 

 

Read.CSV() 

Read.DIAdem() 

Read.Equation() 

Read.ISO() 

Read.LSPP() 

• Case 46211 
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The Graph class functions .Delete() and .DeleteFromID() were not removing the graphs 

properly. Now fixed. 

Menus 

• Case 45940 

The behaviour of the scroll bar in the EM menu has been improved. 

Program crash 

• Case 46817 

Fixed a crash that could occur in T/HIS 18.0 while performing some dynamic viewing 

operations. 

• Case 46324 

In the Curve History menu, the delete operation is now hidden when more than one curve is 

present to avoid T/HIS crashes. 

Program hanging 

• Case 46828 

Fixed an issue where the integration point selection menu for LS-DYNA reading would persist 

when swapping to another reading menu (e.g. T/HIS Curve) and potentially cause T/HIS to hang. 

Read 

• Case 46850 

When creating a curve directly from the screen using the mouse to pick points, the mouse scroll 

wheel did not work to zoom in/out. Now fixed. 

• Case 46643 

When trying to plot Effective Plastic Strain for Thick Shells from a THF source, all Y data 

would be output as zeroes. This has now been fixed. 

 

Fixed a bug that occurred when plotting Effective Plastic Strain for Thick Shells from an LSDA 

binout file. In some situations, it was not possible to access specific through-thickness 

integration point data for binout files only containing elout data. This has now been resolved. 

• Case 46606 

T/HIS could plot nodal displacements incorrectly from d3thdt files output from LS-DYNA 

versions R11 and later. Now fixed. 
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• Case 46563 

CURVOUT ASCII files will now be read in correctly if being read in with a BINOUT file. 

• Case 46549 

Thick shell strain data could be plotted incorrectly from a d3thdt file output from newer versions 

of LS-DYNA. The XX strain would be plotted with the YY strain value, YY with the ZZ values, 

etc. This has been fixed. 

• Case 46335 

Extract curves to match model no longer causes a linked D3PLOT-T/HIS session to crash. 

• Case 46182 

T/HIS can now support ISO-MME files written out by Altair HyperGraph. 

Scripting 

• Case 46509 

Launching the GUI Builder from a T/HIS session started from D3PLOT caused a crash. This has 

been fixed. 

T/HIS link 

• Case 46583 

Setting a shortcut key in T/HIS to open the image menu didn’t work in a D3PLOT-T/HIS linked 

session. This has been fixed. 

Text 

• Case 46691 

Fixed an issue where text could be lost on a textbox when copy and pasting. 

User interface 

• Case 41794 

A scroll bar has been added to the Title/Axis menu. 

User defined 

• Case 46953 

Fixed a potential crash or error when creating a User Colour within T/HIS. 
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2.4 REPORTER 

2.4.1 Bugs Fixed in 18.0 

Capture 

• Case 45224 

If you open a template created in REPORTER 16.1 or earlier in REPORTER 18.0 or later, any 

D3PLOT and T/HIS items will continue to be captured and generated using the old pre-version-

17 method (in versions 17.0 and 17.1, they were automatically converted to the new method, but 

this caused problems for some users’ templates). 

• Case 45056 

Fixed an issue where D3PLOT Items would sometimes fail to load the image when conducting a 

fresh 'old method' Capture. 

Library 

• Case 45562 

The 'LS-DYNA Version and Revision' version.js Library Program script has been updated so 

that it works with newer d3hsp/OTF files that can include: 

1. An Ansys legal notices header above the LSTC header 

2. LS-DYNA revision names incorporating the newer Git revision hashes instead of the 

older SVN revision numbers 

Shortcut 

• Case 43423 

All main window keyboard shortcuts can now be used while the Logfile has focus. 

Standard templates 

• Case 45644 

Fixed an issue that could prevent the GTR Head Impact 2020 template from updating properly 

after you Edit Settings from any of the buttons on the template. 

• Case 45423 

In the IIHS Side MDB Impact 2017 template, if you Set Observations on page 2 after the 

template had generated, then any changes to the head protection rating were not then reflected in 

the Overall rating displayed on page 1. Now fixed. 
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• Case 45386 

In the USNCAP templates, the Nij calculation and chest transducer rotation for the HIII 5F 

passenger were using the same values as for the HIII 50M driver. Now fixed. Additionally, the 

HUMANETICS_HIII_5F_V2.0.2 dummy info now looks for cross sections rather than beams 

for upper neck and femur inputs so as to be consistent with the FE model. 

• Case 45098 

In many of the standard templates, calculations of compression forces were given the incorrect 

sign when run with LSTC dummies. In addition, some body region calculations were not 

considering both negative and positive values when comparing against rating limits. These errors 

have now been fixed. 

• Case 45097 

In the CSV files for LSTC HIII 50M dummies in reporter_library/templates/dummy_info, the 

knee slider inputs were incorrectly configured as spring elements. They are now configured 

correctly for *JOINT_STIFFNESS. 

User interface 

• Case 45632 

The page number in the main window title bar will now correctly display the current page 

(usually the last in the Template) after report generation. 

• Case 45394 

The page number listed in the page navigation box should now correctly correspond to the 

current page (usually the last in the Template) after writing a PDF, PowerPoint, or HTML file. 

• Case 44362 

The JavaScript function Template.EditVariables now accepts an optional boolean argument to 

determine whether selected Variables should be displayed alphabetically (true) or in the list order 

in which they were passed to the function (false). 

• Case 43422 

The filename in the main window title bar will now correctly have an asterisk appended to it to 

indicate the file has been modified when Variables are edited or updated. 
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• Case 14096 

All dialogs accessed via the menu bar (or created via JavaScript) should now appear on the same 

display screen as the main window. If manually repositioned, these dialogs should remember 

their previous position when being reopened. When moving the main window to a new display 

screen, all of these dialogs should follow to the new screen (excluding an open Logfile or a 

maximised dialog). 
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2.4.2 Bugs Fixed in 18.1 

Capture 

• Case 46113 

Updating an image capture for a D3PLOT Item with an image file extension of .jpg, .bmp, or 

.ppm will no longer overwrite these extensions with .png. 

Image 

• Case 46521 

T-HIS Items with JavaScript type and Image output were not producing an image on Generate. 

This is now fixed to behave in the same manner as old method FAST-TCF capture. Old T-HIS 

Items with JavaScript type and Image output that had been configured to work correctly by 

writing the image from the JavaScript may need to be edited. 

PowerPoint 

• Case 45660 

When running REPORTER in batch from SHELL with REPORTER iconised, a windowing bug 

was causing the Combined Output Options to occasionally produce corrupted files. Now fixed. 

Qt 

• Case 46461 

REPORTER 18.0 would crash when run through Xvfb unless particular settings were used. Now 

fixed. 

Standard templates 

• Case 46756 

Corrections have been made to the neck and femur inputs for Humanetics Harmonized HIII 5F 

v2.02 model dummies so that they use cross sections rather than beams (in a small number of 

templates). 

• Case 46588 

Fixed a bug that could report an incorrect score from the femur compression exceedance curves 

in various automotive library templates. 
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• Case 46017 

The neck and femur loadcell inputs were incorrectly assigned ‘Beam’ entity type in the 

dummy_info CSV files for Humanetics SID IIs SBLD v.4.3.1.csv and Humanetics SID IIs 

SBLD v.4.3.2.csv. They are now correctly assigned as cross sections, enabling the PRIMER GUI 

for selecting model inputs to function correctly. 

• Case 45797 

The PRIMER GUI for selecting model inputs could fail if your model contained a very large 

number entities in DATABASE cards (e.g. a DATABASE_BEAM_SET containing thousands of 

beam elements). This has been fixed by capping the number of entities displayed in the 

DATABASE card popups to 100 for each entity type. You can still specify an entity ID that 

doesn’t appear in the popup by picking/selecting it or by entering its value. 

Tables 

• Case 46292 

We have improved REPORTER’s handling of file paths for the Autotable ‘File’ 

option. Updated guidance has been added to the manual. 

Text 

• Case 43230 

Right-aligned text was sometimes clipped in PDF output. Now fixed. 

Variables 

• Case 46258 

%TEMPLATE_DIR% was not set early enough when a Template was being opened, causing 

Image Items that were attempting to use this variable to appear as ‘missing images’. Now fixed. 
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2.5 SHELL 

2.5.1 Bugs Fixed in 18.0 

Filename 

• Case 45456 

If there is a space in the *KEYWORD_ID card fields, the SHELL was unable to submit the 

model for LS-DYNA run. This has been Fixed. 

• Case 43407 

Support panel leaves a grey patch upon dismissal on Linux machine. This has been fixed. 

Edit 

• Case 44046 

When the 'dyna_versions' file is not present, the default CPU settings were not imposed in the 

SHELL submit panel. This has been fixed. 

Filename 

• Case 43630 

LS-DYNA submission fails from certain directories with whitespace in path. This has been 

fixed. 

Memory 

• Case 44389 

For the command line SHELL, the memory value conversion was incorrect at times. This has 

been fixed. 

Sensor 

• Case 44649 

Kill Switches did not work for LS-DYNA submission with LSTC format outputs. This has been 

fixed. 
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User interface 

• Case 44531 

Added new environment variable 'SHELL_REMOTE_FAST' to launch faster (non-iconised) 

versions of the SHELL GUI on the Remote Linux machines. 

• Case 44398 

Re-configured the PRIMER/D3PLOT and T/HIS 'Options' panels for widgets consistency and 

usage. 

• Case 44289 

On Linux the PRIMER 'Options' panel was getting launched in Full-screen size. This has been 

fixed. 

• Case 44091 

The SHELL main menu popups were not mapped with the Left-mouse click on the buttons like 

'Themes', 'Manuals' and 'Utilities'. This has been fixed. 

• Case 43898 

Corrected the widget label string for processors in the Submit panel. 
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2.5.2 Bugs Fixed in 18.1 

Memory 

• Case 46134 

The MEMORY units conversion was not correct for the command-line SHELL. Fixed this. 

User interface 

• Case 46943 

The popup menu for 'Utilities' was mapped even if there are no utility functions defined. Fixed 
this. 

• Case 46934 

While performing 'ONLINE' submission in the command-line SHELL, a false error string was 
being printed. Fixed this. 

• Case 46791 

D3PLOT Options: Rename checkbox option from '3D Viewer Export' to 'D3PLOT Viewer'. 

• Case 45943 

Removed the term 'PLATFORM' from the description of a new LS-DYNA entry inside the 
dyna_versions file - created by the SHELL when 'Add versions' button is pressed. 

Variables 

• Case 47019 

The value strings for environment variables were getting culled. Fixed thi. 
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2.6 Oasys 

2.6.1 Bugs fixed in 18.0 

Program hanging 

• Case 43859 

 

Fixed an issue on Windows where, when process A fired off linked process B (e.g. PRIMER 

launched a linked D3PLOT session), and then process A terminated normally, its console (MS-

DOS) window got 'left behind' until child process B was eventually killed. 

User interface 

• Case 43485 

 

The dashed outline for the most-recently-selected tree item is now coloured more suitably for the 

current GUI theme. Additionally, the right-hand and bottom borders have been shifted in by 1 

pixel so they no longer get left behind when a different item gets selected. This applies to all tree 

menus in PRIMER, D3PLOT & T/HIS. 

 

• Case 43485 

 

Fixed an issue where the unblanked status of selected items in the Part Tree could become lost. 
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2.6.2 Bugs Fixed in 18.1 

Preferences 

• Case 45962 

When closing the splash screen a message was being displayed in the dialogue box saying that 
it's saved the 'font_quality preference ANTI_ALIAS'. From version 18 this is the default option 
already, there was no need to do it any more so that is now removed. 

 

User interface 

• Case 46114 

When launching D3PLOT or T/HIS at smaller window/screen sizes, one of the new feature 
buttons on the splash screen could be mislabelled with a PRIMER feature. This has now been 
corrected. 
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3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

3.1.1 Enhancements in 18.0 

Animation 

• Case 42863 

PRIMER's boundary prescribed motion animation function now permits you to specify an 

analysis timestep of your choice that can override the default value computed by the function. 

Belts 

• Case 44271 

Added the option to create *AIRBAG_REFERENCE_GEOMETRY automatically when 

meshing seatbelts (for nodes on the seatbelt that are meshed in SHELLs). Option available in 

panels: 

- Mesh - Tickbox 

- Auto-refit - Radio button 

• Case 43682 

Seatbelt fitting enhancements: 

- Duplicated some fitting parameters on the popup panel to make them more obvious 

- Added a dropdown menu (with 4 levels of mesh fineness) to control 'Max curve angle', 'Belt 

length' and '#rows' 

• Case 43627 

Changes made to the seatbelt fitting panel: 

- Added 'Pause' button - duplicate of 'Stop' button 

- Added 'Step' button - next by 1 iteration 

- Replaced 'Restart' button with 'Reset' button - back to initial state (because 'Restart' is just 

'Reset' + 'Fit') 

- Changed buttons to icons - added hover text and button alias 

• Case 42693 

Seatbelt fitting - increased maximum '#rows' from 19 to 100 
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Checking 

• Case 45214 

Added a model check for MAT_054 where if DFAILT > 0 then DFAILC must be < 0. 

• Case 42073 

A new text box has been added on the LS-DYNA output reader panel which informs whether the 

analysis has terminated properly or not. 

Clipboard 

• Case 44277 

Header box in Clipboard object selection menu now updates to reflect number of items being 

added or removed. 

Compare 

• Case 44731 

Part compare write to Excel format now indicates whether the filename already exists by 

showing the text in a red colour. The panel is now unmapped once the write to Excel is 

complete. 

Connections 

• Case 43692 

PRIMER's merge bolt connection requires that rigid shells of the bolt overlap deformable shells 

of the layers. This is necessary as emptying the connection involves deleting the rigid shells. 

 

The connection tool 'From FE' has been enhanced to handle the case where the rigid shells are 

not initially overlapped with deformable by creating deformable shells on them so the connection 

can be created. 

Contacts 

• Case 45075 

*CONTACT_AUTOMATIC_GENERAL_INTERIOR is now included in the segment edge 

check phase of contact checking. 
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Contour 

• Case 44070 

The values Area (for shells only) and Volume (for beams, shells, solids and thick shells) have 

been added to the list of data components that can be contoured as element properties in SI/CT 

mode. 

Cut Section 

• Case 45206 

Cut sections modifications: 

- Added a custom spacing option to PRIMER's multiple cut sections feature. 

- Added PRIMER manual links to help messages for thick cuts and multiple cuts. 

Element quality 

• Case 45707 

Added max solid spotweld/adhesive warpage to the CHECK OPTIONS panel Quality category. 

Encryption 

• Case 44252 

The ability to read partially encrypted *AIRBAG cards has been added. 

 

The *AIRBAG must have suffix _ID and the first line of: 

 

[Label] [Title] 

 

must be provided in clear. Thereafter PGP encryption can start on any line. 

 

The implications inside PRIMER are as follows: 

 

- Checking is suppressed for encrypted airbags since it is assumed that no data values will be 

known. 

 

- The PGP data is remembered and reproduced verbatim on keyout. 

 

- If the model also contains partially encrypted loadcurves these will be locked against deletion if 

the model also contains encrypted loadcurves (or materials, as before). 

 

 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 18.1 
 

Ove Arup and Partners Limited | Final | October 2021  

 

Page 88 
 

Graphics 

• Case 44661 

The 'Saved properties' panel was a bit obscure, since the only way of accessing it was to hover 

over the [Save P] button. 

 

Two new ways of invoking it directly have been added: 

 

(1) A direct access from the [Display] popup menu. 

(2) Via the short-cut key '~'. (Like all keyboard shortcuts the key can be re-assigned) 

 

In addition in the Saved Properties panel itself the [Reset attributes] popup menu has been added, 

giving an easy way of resetting visual attributes. 

IGA 

• Case 44507 

Added warning if NODE is referred to by *ELEMENT_SHELL_NURBS_PATCH 

• Case 44473 

Added support for mass calculation for *ELEMENT_SHELL_NURBS_PATCH 

• Case 44242 

Added high order basis function checks to *ELEMENT_SHELL_NURBS_PATCH. 

• Case 44241 

Added checks on NISS/NISR and PS-PR fields to *ELEMENT_SHELL_NURBS_PATCH. 

Implicit 

• Case 45483 

A new tool has been added to help setup the *CONTROL cards required to run various types of 

implicit analyses. This tool can be accessed from the 'Implicit' button on the Tools panel. The 

tool offers a selection of implicit analysis types: Static, Transient (Direct or Modal), Buckling 

(standalone or intermittent), Eigenvalue (standalone or intermittent), Frequency Domain (FRF). 

 

By default, the tool will open in a simplified mode which requires less input to setup the 

different analysis types, however an advanced mode is also available to allow more 

customisation/use of non-standard options. 
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Include 

• Case 43009 

Added new warning text below the text box if file exists. 

JavaScript API 

• Case 44917 

The _MORTAR keyword option can now be set on supported contact types using the Contact 

JavaScript class. 

• Case 43767 

Added new SensorDefine class to PRIMER JavaScript API. 

• Case 43625 

A GUI Builder has been added to the JavaScript menu to allow you to interactively create 

windows and widgets for a JavaScript GUI, rather than having to code it by hand. This is present 

in PRIMER, D3PLOT and T/HIS. 

Keyword Editor 

• Case 44671 

Enabled keyword editor for * ELEMENT_SOLID_NURBS_PATCH with first two cards. 

Macro 

• Case 45190 

Added new preference 'write_checkpoint_files' and a command line option with the same name 

to regulate the writing of the checkpoint files in PRIMER. 

Manual 

• Case 43024 

Added access to the LS-DYNA User Manuals from Help → Keyword manuals. 

Mass 

• Case 43728 

Assign mass using *ELEMENT_MASS_PART creates new definitions in the same include as 

the *PART, using *ELEMENT_MASS creates them in the same include as *ASSIGN_MASS. 
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This behaviour is now switchable on the main panel (or by preference settings) so you can use 

PART includes or ASSIGN_MASS includes as you wish. 

Measure 

• Case 42415 

Added new option for number format similar to D3PLOT. 

Mechanism 

• Case 42958 

Added new preferences for value related options in Mechanism → Position → Options. 

Mesh 

• Case 44109 

The user now has extra control over splitting quad shell into two tria shells. The user can choose 

the diagonal along which the shell has to be split. Four options are now available for the user:  

1. Short diagonal  

2. Long diagonal  

3. N1 → N3  

4. N2 → N4 

• Case 43741 

A Settings button has been added to the Geometry Meshing panel and Area Remesh panel which 

will take the user to Program → Meshing options where meshing parameters can be changed. 

Pedestrian 

• Case 43142 

'Line Labels' labelling style is added to pedestrian markup script in PRIMER. 

Read 

• Case 45461 

Added the preference to read any file as a *KEYWORD file irrespective of the extension (like 

*.inp, *.dat etc.) or read based on the file extensions. 

• Case 34393 

Added support for Dragging and Dropping of IGES, JT, LAYUP, NASTRAN and ABAQUS 

filetypes to improve support for geometry. 
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Renumber 

• Case 44608 

Added sorting functionality in Renumber → Visualise panel. 

Scripting 

• Case 43305 

Added JavaScript support for *CONSTRAINED_LINEAR_GLOBAL and 

*CONSTRAINED_LINEAR_LOCAL. 

- New Linear class. 

- JavaScript API manual updated. 

• Case 43141 

As per ECE R42 regulation, Slow Speed Front 4 & 2.5kmph and Slow Speed Rear 4& 2.5kmph 

test setup added to standard crash test setup script. 

User interface 

• Case 45563 

On some VMWare installations the status of the 'Shift' and 'Control' keys is not reported 

correctly with the result that these keys can appear to be 'stuck' in the pressed state. 

 

It is possible to determine the state of these keys by secondary means, and although this is not 

the default this option can be turned on by setting environment variable 

SM_VMWARE_BUGFIX. 

 

This is quite a rare problem and users should discuss it with Oasys Ltd first to see if a better 

solution is available. 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 18.1 
 

Ove Arup and Partners Limited | Final | October 2021  

 

Page 92 
 

3.1.2 Enhancements in 18.1 

Checking 

• Case 45921 

When checking/plotting minimum length of elements, PRIMER will now use timestep size (for 

shells, it depends on the *CONTROL_TIMESTEP <ISDO> field) when the new preference 

primer*check_min_length_timestep is set to TRUE. 

Integration 

• Case 46571 

When PRIMER and D3PLOT are linked together, and D3PLOT has more than one window open 

on the linked model, and D3PLOT is using different blanking settings in each window then a 

problem could occur that: 

 

+ User made a blanking change in D3PLOT W1 

+ This caused blanking in PRIMER to update (correctly) 

+ The updated blanking in PRIMER would then 'echo' back to W2 in D3PLOT, causing its 

blanking status to change (wrongly). 

 

This has been fixed by making PRIMER distinguish between blanking changes made locally 

(which should be transmitted to linked D3PLOT), and blanking changes received from linked 

D3PLOT (which should be echoed back). 

 

This fixes the immediate problem, however because PRIMER only has a single graphics window 

it is not capable of 'remembering' the per-window blanking status in D3PLOT. Therefore when a 

local blanking change is made in PRIMER it will affect all linked windows in D3PLOT, 

effectively harmonising them. This isn't a bug, just a feature of linking the two codes together. 

• Case 46568 

When PRIMER was running with linked D3PLOT it would sometimes be the case that when the 

model was hovered over by the mouse in PRIMER this would cause the view in linked D3PLOT 

to be updated. This could result in unwanted effects when D3PLOT had more than one window 

and different blanking settings in each window. 

 

Fixed by reducing the frequency with which view updates are sent from PRIMER to D3PLOT. 

Previously they would be sent pre-emptively whenever the plot was redrawn, which could 

happen in some predictive pick scenarios. Now they are only sent if the current view has actually 

changed. 

Pedestrian 

• Case 46398 

• In the Pedestrian Markup tool, when running the GTR / UN R127 protocol: 
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• - The lower leg height has been updated from 25mm to 75mm 

• - The bumper test zone inboard offset has been updated from 66mm to 42mm 

• Case 46158 

Support added to the Pedestrian Markup tool for the EuroNCAP v9.0 Testing Protocol. 

 

- The windscreen rear reference line (WRRL) can either be calculated by finding the rearmost 

free edge of the selected windscreen part (default), or by determining where a vertical stick 

rotated rearwards by 45 degrees would touch the windscreen. This can be set via the Rear 

Reference Line window or a .pmset settings file. 

 

- Cyclist head impactor orientation angles can be set via the new 'Cyclist' (Angle) and 'Roof' 

(Angle) textboxes in the Impactor window after markup. 

 

- A pre-existing Cyclist head impactor template .csv file can be used by setting the new 

preference 'primer*pm_cyclist_head_template. 

• Case 45826 

As described in EuroNCAP Testing protocol v8.2 section 3.6, the Pedestrian Markup tool now 

projects the corner reference point forward to the WAD 775 line. The tool will also draw a line 

joining the corner reference point and projected point, along the outer contour of the vehicle, to 

make it easier to visualise. The corner reference point and its projected line/point can be viewed 

in the markup line model via the corresponding *SET_NODEs, and will be written out when 

outputting head impact boundary lines. 

• Case 45794 

Support for the CNCAP 2021 protocol has been added to the Pedestrian Impact Markup tool. 

Settings and writing of impact points between the WAD 2100-2300 lines can be controlled using 

the 'Cyclist' options on the impact points window. 

Performance 

• Case 44558 

Previously, quickly releasing the mouse button after right-clicking on a popup button could 

sometimes result in selecting an unwanted option from the popup box (e.g. in the connection 

table). The behaviour of item selection from popup boxes has now been changed to stop this 

from happening. 
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3.2  D3PLOT 

3.2.1 Enhancements in 18.0 

Blanking 

• Case 43608 

In D3PLOT 18.0 the Blank menu now has a propagate tab '==>' which can be used to propagate 

the blanking from one window to another.  

 

In D3PLOT, blanking is a per-window attribute. This means that if a model is displayed in more 

than one window, then different items in the model can be blanked in different windows.  

 

The new propagate tab can be used to synchronise the blanking across all the windows a model 

is in. The blanking status is copied for each model in the 'source' window to all of the selected 

'target' windows that the model exists in.  

 

If for example you have: 

 

Window 1 - Containing Models 1 & 3  

Window 2 - Containing Models 1 & 2  

Window 3 - Containing Model 2 & 3  

Window 4 - Containing Model 4  

 

and you copy the blanking from Window 1 to the other windows then afterwards: 

 

Window 1 - No changes  

Window 2 - Model 1 blanking changed to match Window 1  

Window 3 - Model 3 blanking changed to match Window 1  

Window 4 - No changes  

 

 

The Blanking menu also has a new 'M ==> M' button that can be used to propagate the blanking 

from one model to one or more other models. Items are matched by type and ID so the blanking 

status of PART 1 in the 'source' model is copied to PART 1 in the 'target' model(s). If PART 1 

does not exist in a target model, the status is ignored.  

 

If a target model contains items that do not exist in the source model, then their status is 

unchanged. 

Contacts 

• Case 43597 

In D3PLOT 18.0 the default is now to automatically blank contact segments if the underlying 

element is blanked. This works for both blanking individual elements and when a part is blanked.  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 18.1 
 

Ove Arup and Partners Limited | Final | October 2021  

 

Page 95 
 

The Blank menu also has a new Options menu in which this new behaviour can be switched off. 

It also contains an option to swap the parent element to the first 3D element (solid or thick shell) 

instead of the first shell.  

 

New preference options have also been added to switch the new logic off by default and to swap 

the default parent to the first 3D element if required. 

Cut section 

• Case 45036 

In D3PLOT 18.0 a new data component has been added for cut sections: 

 

FM_MAGNITUDE_CUT_FORCE  

 

Previously the X,Y and Z forces could be output in both the Write and XY Data menus, but not 

the resultant.  

 

This component has also been added to the CUT_SECTION_SUMMARY data component in the 

Write menu so the resultant force is also now output along with the other cut section data. 

• Case 30447 

Cut sections modifications:  

- Added a custom spacing option to D3PLOT’s multiple cut sections feature 

- Added D3PLOT manual links to help messages for thick cuts and multiple cuts 

D3PLOT Viewer 

• Case 37286 

D3PLOT can now output models in the 3D GLB format with support for shaded and contoured 

plots and single frame or animated output. GLB files output from D3PLOT are best viewed in 

D3PLOT Viewer, but can be viewed in other viewers, e.g. in Microsoft PowerPoint, with 

reduced functionality. 

Data components 

• Case 43708 

D3PLOT can now calculate and contour section forces for thick shells of Gaussian, Lobatto, 

Trapezoidal and part composite sections. By default, section forces for thick shells are switched 

off, but can be switched on in Display Options → Thick Shells or by setting environment 

variable TSHELL_SHOW_RESULTANT to TRUE. 

 

https://d3plotviewer.com/
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Include 

• Case 44986 

There is now the ability in Quick Pick, under Colour, to Colour by Include. 

Macro 

• Case 45191 

Added new preference d3plot*write_checkpoint_files and a command line option with the 

same name to regulate the writing of the checkpoint files in D3PLOT. 

Materials 

• Case 45293 

Updated the file mat_prop.csv with the latest material history variable names. 

Measure 

• Case 37467 

A new Measure class has been added to the D3PLOT JavaScript API. It allows you to create 

measurements and to draw them in the graphics windows with similar options to those available 

on the interactive Measure panel. 

Menus 

• Case 42550 

The new colour popup has been added in the following places:  

- Airbag particles 

- Watermark transparent colour 

- Blob plot symbol colour 

- Streamlines 

- Using the Edit window to set model colours 

- The hidden and fill colours for Crit, Vel and Vec plots 

- The current overlay colour for the window 

- Setting the edge colour for the undeformed geometry 

Movies 

• Case 37615 

D3PLOT can now read MP4 files into a window background for synchronised playback with 

model animation, similarly to old functionality using AVI files. 
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• Case 30717 

D3PLOT is now able to write video files in the MP4 format using H.264 encoding. Model 

animations can be captured in MP4 format and passed to an open REPORTER session for 

playback. 

Preferences 

• Case 44526 

Added a preference d3plot*mat_prop_location to allow a user-defined location for the file 

mat_prop.csv of material history variables. 

User interface 

• Case 44636 

It is now possible to capture animations to REPORTER by selecting Movie or GIF from the 

drop-down menu on the REPORTER panel Capture button. 
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3.2.2 Enhancements in 18.1 

Integration 

• Case 46570 

When D3PLOT and PRIMER were linked and a part was blanked in PRIMER, it would be 

blanked in all windows in D3PLOT, including windows that were not selected. Now, blanking in 

PRIMER is only mirrored in selected windows in D3PLOT. 

Menus 

• Case 46115 

In D3PLOT 18.0, propagation behaviour for window and model settings was changed to launch 

a popup giving greater control than in previous versions. To reduce button clicks, two propagate 

tabs are now provided: ‘==>’ for auto-propagate and ‘…’ to launch the propagate popup. 
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3.3 T/HIS 

3.3.1 Enhancements in 18.0 

Component 

• Case 44980 

T/HIS 18.0 supports the following new data components that can be written to the Airbag ASCII 

file ABSTAT of the LSDA (binout) file.  

- Mass out  

- Mass in  

- Mass out through fabric  

- Mass out via vent  

These new options are output instead of the mass flow rates by setting MLKBAG on 

*CONTROL_OUTPUT. 

Data access 

• Case 40883 

When reading ISO-MME data, the curves listed in the menu can be filtered by location in the 

model, e.g. Head, Foot, Wheel. 

Data components 

• Case 44852 

T/HIS 18.0 supports the 'torsion' data component that can now be written out for spotweld beams 

to the LSDA (binout) and ASCII (swforc) output files. 

• Case 44820 

T/HIS 18.0 now supports the following new data components for seatbelt sliprings:  

- Warp angle  

- Skew angle  

- Coulomb friction coefficient  

- Spring normal force  

- Side 1 belt force  

- Side 2 belt force 
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FAST-TCF 

• Case 44320 

A 'Script generated' message is now displayed in the command window upon the generation of 

FAST-TCF script. 

JavaScript API 

• Case 44922 

Constants have been added to the Read class which can be used in the various Read functions. 

• Case 42784 

New properties label_font and label_size have been added to the Datum class in the JavaScript 

API, to allow the font and font size to be set for datums via JavaScript. The properties can take 

values assigned using Datum class constants that can be found in the user manual. 

Macro 

• Case 45192 

Added new preference 'write_checkpoint_files' and a command line option with the same name 

to regulate the writing of the checkpoint files in T/HIS. 

Menus 

• Case 45074 

A dynamic Location pop up that sets up options according to channel list has been added to the 

ISO menu. 

• Case 44848 

The Curve Label pop-up has been added to the ISO menu with new options Channel Code or 

Channel Name. 

Read 

• Case 43569 

The time taken to read a large T/HIS curve file back into T/HIS has been considerably reduced in 

version 18.0.  

 

This speed up is even more noticeable in the linked D3PLOT-T/HIS case when a large number 

of curves or points is sent to T/HIS from D3PLOT. 
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• Case 42584 

Added T/HIS reading support for EM ASCII file types:  

 

em_boundaryOut  

em_circuit  

em_circuit0D  

em_circuitRes  

em_timestep  

em_rogoCoil  

em_globEnergy  

em_partData  

em_isoPotConnOut  

em_isoPotOut  

em_randlesCell  

em_randlesCellTot  

em_randlesCellTotEn  

em_randlesIntShort  

em_randlesIntShortTot 

• Case 15901 

An option has been added to the Read → ISO-MME menu to label the curves with the Channel 

Code, rather than the Channel Name. 

• Case 44599 

Support has been added to the ISO Read menu so that it can read v2.0 of the format. 

• Case 45475 

Added support for the new EM files with em_file_xxx.dat format to be read in when reading 

using the 'Multiple Directories' option. Also added support for volume 3 (ICFD,CESE and EM) 

files to be read in if they have a prefix when using multiple directories. 

Units 

• Case 45474 

Added ‘charge’ as a unit in T-HIS. 

Write 

• Case 43968 

A new option has been added to the Write menu to output curves in the ISO-MME format. 
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3.4 REPORTER 

3.4.1.1 Enhancements in 18.0 

Licensing 

• Case 44733 

Along with the rest of the Oasys Suite, REPORTER has transitioned to LM-X licensing for 

version 18.0, so the FLEXlm licence is no longer supported. 

Movies 

• Case 3485 

Support for the playback of MP4 movies and animated GIFs has been added to REPORTER. 

These can be captured directly from D3PLOT for use with a D3PLOT item or be added to a 

template through an image or image file item. Playback can be controlled by hovering over the 

item or using the buttons in the new animation toolbar. 

Powerpoint 

• Case 44261 

You can now use the -pptx command line argument to trigger PowerPoint output. Both -pptx and 

-ppt arguments have the same behaviour (they output .pptx files).  

 

Similarly, the JavaScript API method Template.Ppt has been deprecated in favour of 

Template.Pptx (both continue to output .pptx files). 

• Case 44259 

REPORTER has been able to write PowerPoint (.pptx) files since version 11. In REPORTER 

18.0 support for the old .ppt VBA output has been removed. 

Preferences 

• Case 44540 

The first sixteen colours saved in PRIMER, D3PLOT or T/HIS are now read into REPORTER 

via the user_colours.xml file and are accessible via the 'Custom colors' panel (select 'More 

colours…'). Any user colours added in REPORTER via 'Add to Custom Colors' can be saved to 

user_colours.xml via the new 'Fonts and Colours' tab in the Preferences dialog and will thereafter 

be accessible in PRIMER, D3PLOT and T/HIS. 
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• Case 39537 

Font settings can now be saved directly from REPORTER via the new 'Fonts and Colours' tab in 

the Preferences dialog. There is also a new 'Startup' tab with preferences for maximising the 

main window, and also to specify the starting directory for REPORTER (previously these 

preferences could only be modified via the preferences editor in the other programs). 

Standard templates 

• Case 44532 

The part lists necessary for the MPDB deformation algorithm are now exposed in the 

unencrypted script d3plot_MPDB_barrier_parts_blanking.js, allowing the template to be 

adapted to work on modified or third-party FE models. 

• Case 44115 

Following the release of Euro NCAP MPDB Compatibility Assessment templates in version 

17.1, REPORTER 18.0 includes the C-NCAP MPDB Compatibility Assessment templates, with 

variants for 2022 and 2023 scoring. For more information on the templates, open REPORTER 

and select Help → Additional user guides. 

• Case 44013 

Improvements were made to the MPDB Compatibility assessment barrier deformation 

calculation to eliminate flying elements from consideration. 

Text 

• Case 44127 

You can now specify a font mapping table CSV file in a location other than the installation 

location, to make customised font mapping more convenient. 

User interface 

• Case 45506 

The Legacy GUI theme has been deprecated and is no longer accessible from the Preferences 
dialog. If you wish, you can still select Legacy theme via reporter*gui_theme in your oa_pref 
file. 

• Case 42966 

The 'LS-DYNA' tab in the Preferences dialog has been renamed 'Oasys Items'. All of the settings 
in the Program Locations dialog have been moved to this tab, and they can now be saved from 
REPORTER along with the other preferences. 
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3.4.2 Enhancements in 18.1 

JavaScript API 

• Case 45772 

The filetype, job, resolution, and cropping properties have been added to the Javascript Item 

class (for certain Item types). 

Standard templates 

• Case 46507 

A new template has been added for C-NCAP Head Impact 2021. 

• Case 46506 

A new Euro NCAP Head Impact 2023 template has been added, with updates to process Cyclist 

impacts according to the latest protocols. 

• Case 46494 

A new C-NCAP Leg Impact 2021 template has been added. 

• Case 46493 

A new Euro NCAP Leg Impact 2023 template has been added, with updates to process the aPLI 

impactor according to the latest protocols. 

• Case 46314 

New MPDB Occupant Assessment templates have been added for the latest C-NCAP and Euro 

NCAP protocols. These templates process the THOR 50M driver dummy, as well as the HIII 

passenger (5F for C-NCAP, 50M for Euro NCAP). 

• Case 45106 

A new GTR Leg Impact 2019 template has been added. 

• Case 43858 

For the femur calculation in pedestrian leg impact templates, the data can either be a beam or a 

contact depending on the upper leg impactor specified. We have now ensured that the correct 

data is extracted, defaulting to beam elements if the type is unspecified. 
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3.5 SHELL 

3.5.1 Enhancements in 18.0 

D3PLOT Viewer 

• Case 44752 

Added support to write out the 3D Export (GLB) files from the D3PLOT options panel. 

ISO-MME 

• Case 44771 

Added support for ISO-MME to SHELL’s T/HIS options panel. 

Macro 

• Case 45193 

Added support to regulate the Read/Write of the Checkpoints files in the D3PLOT, PRIMER and 

T/HIS options panels. 

PowerPoint 

• Case 44498 

Removed the obsolete VBA output option from the REPORTER options panel. 

3.5.2 Enhancements in 18.1 

Command files 

• Case 46790 

D3PLOT Options: Added a new option to output 'uncompressed' GLB files. 
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3.6 Oasys 

3.6.1 Enhancements in 18.0 

Integration 

• Case 43511 

 

Models loaded into a PRIMER session can be submitted for LS-DYNA analysis directly from 

within PRIMER. The LS-DYNA job submission can be done on the same machine as PRIMER 

or on a networked Linux machine. 

Performance 

• Case 44551 

 

Various keyboard shortcuts have been added to speed up text selection: 

 

Shift + Left Arrow : Highlights from the current cursor position to the left by one character 

Shift + Right Arrow : Highlights from the current cursor position to the right by one character 

Shift + Up Arrow : Highlights from the current cursor position to the left-most character in the 

string (0 or prefix) 

Shift + Down Arrow : Highlights from the current cursor position to the right-most character 

(length of the string) 

Ctrl + Left Arrow : Jumps the cursor from the current cursor position to the left-most character 

of the word 

Ctrl + Right Arrow : Jumps the cursor from the current cursor position to the right-most 

character of the word 

Ctrl + Shift + Left Arrow : Highlight the rest of the word to the left of the cursor position up to 

the breaking character 

Ctrl + Shift + Right Arrow : Highlight the rest of the word to the right of the cursor position up 

to the breaking character 

Double Click Left Mouse Button : Highlights the whole word 

Triple Click Left Mouse Button or Ctrl + A : Highlights the whole line 

 




